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Activating Capture One Pro 7
Follow this step-by-step guide on how to activate Capture 
One Pro 7 software. In order to complete the activation you 
need to be connected to the Internet.

1. Go to Capture One>License... to open the license  
activation dialogue as illustrated.

2. Enter license code and profile details. You will receive 
the 16-character license code either by email or with the 
original software package. Type in the license code as  
illustrated.

Type in your email address that correlates to your Phase 
One Account, if you do not have an account one will be 
created for you. Press ‘Get profile’ and the rest of the form 
will be filled in for you. If you are a new customer, please fill 
in the rest of the form. Now click the ‘Activate’ button.

3. Complete this process by clicking ‘Activate’. Your  
software is now ready for use.

Troubleshooting
Try one of the following resources if you are experiencing 
any problems with the software:

1. Read the User Guide found in the Help menu or go direct 
to http://help.phaseone.com for a comprehensive online 
guide to the software.

2. Watch www.youtube.com/PhaseOneDK for the latest 
video tutorials. 
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3. Visit www.phaseone.com/support for inspiration and 
troubleshooting.

Getting Started
This is a guide to getting started with Capture One Pro 7. 
Visit www.phaseone.com/7 for full details on how to get  
the most from the software.

The user interface consists of four key sections as shown in 
the screen shot below:

1. The Browser displays different views of image thumb-
nails, as well as useful functions to aid workflow including 
rating, naming, sorting and more.

2. The Viewer delivers a high quality rendition of your cho-
sen selected image. All changes made to the image will be 
shown instantly.  

3. The Tool Tabs give access to all of the core tools needed 
to edit images, such as color balance, exposure and sharp-
ness.

4. The Menu and Tool Bar provide structured access to 
software functions and features found throughout the  
application.

Sessions
If you are already familiar with and prefer to keep working 
with Sessions, you can choose to do so:

Create a Session as a project container that primarily stores 
folder locations and paths to drives used in a project. For 
quick access and fast loading of folders you can create 
favorite folders for the locations used in a particular project.
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Sessions is especially useful when you are shooting teth-
ered. Simply create a tethered session, plug in the camera 
and capture images directly to Capture One. This saves 
time compared to importing images after a shoot. A shoot 
can be scrutinized as it happens, to help you fine-tune im-
age parameters.

For more info, please go to:
http://help.phaseone.com/en/CO6/Optimizing-Your-Work-
flow/Working-in-Sessions.aspx

Create a Catalog
The alternative to working with sessions is working with 
catalogs.

A catalog is the primary method of file organization and 
viewing in Capture One Pro 7. A catalog contains all the in-
formation needed for Capture One Pro 7 to find and display 
any image added to the Catalog. 

The information includes how the images are organized in 
the catalog, metadata and even what visual adjustments 
are made to the images.
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The location of the actual image files can be on any disc 
location but can also be placed inside the catalog file itself.  
Image files are located and accessed in the Library tool. 
Image files need to be imported into a catalog. It is also 
possible to shoot directly into a catalog from a supported 
tethered camera. 

1 Create a Catalog by selecting File>New Catalog... 

2. A dialog box will appear. Fill in the Name field and select 
a Location for Catalog.

Importing Images
Before you import images, first create a new catalog or 
session. Go to File>New Catalog or New Session. Fill in the 
Name field, select a location and press OK.

There are three primary ways to import image files: 
1. Connect a card reader to your computer and insert a 
memory card. Capture One will open the import window 
automatically. 

2. Import files from your computer or an external hard drive 
by choosing File>Import images...Browse and select a folder 

containing raw images from the Location drop down menu. 

The Import Images dialog box has a number of automated 
options that can be selected according to your workflow 
preference. These include an image backup tool, file nam-
ing functionality and add caption and copyright information 
fields.

3. Shoot tethered from a supported DSLR or Digital Back. 
Images will go to the active Catalog/Session by default.
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Capture
The Capture tool tab is your gateway to tethered shooting 
with a Phase One digital back or supported DSLR. Connect 
a camera to your computer via a FireWire or a USB cable. 

This tool tab has a host of features to aid workflow. Adjust 
your camera exposure settings remotely, apply adjustments 
and multiple styles during capture. Use the Camera tool to 
alter ISO and White Balance settings and fire the shutter of 
a connected camera or activate its Live View functionality. 

Use the Capture Pilot tool/app to connect Capture One Pro 
7 to an iPad, iPod Touch and iPhone. The Capture Pilot app 
lets you present, rate and capture image files on an iOS 
device.

The Capture Pilot tool also has a web function that lets 
you view, rate and color tag captured images from a web 
browser on a computer, Android (mobile device) or  
Windows Phone operating system.
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Color
Capture One provides a number of tools to adjust colors. 
The tools are designed to support your workflow when han-
dling specific issues like white balance and skin tone. 

The Color tool tab and its functionality should always be 
the cornerstone of your image editing workflow. The Color 
Editor enables users to select and adjust a narrow color 
spectrum without affecting other colors in an image. 

Tip: Attain neutral colors by capturing a test shot with a 
grey card during a photo shoot. 
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Exposure
Use the Capture One Exposure tool to adjust exposure, 
contrast, brightness and saturation. 

Try the High Dynamic Range tool to remedy images with 
extreme highlights and deep shadows. Use the powerful 
Levels and Curve tools to fine-tune exposures or add more 
punch to an image with the Clarity sliders. 

Editing images
Try out the Variants function while editing images to get a 
preview of the selected image with the same adjustments 
applied. Use Variants to experiment with different image 
adjustments. 

Press F3/F7 (Mac/PC) to get a Clone Variant of a selected 
image. (Alternatively, Go to Image>Clone Variant). The New 
Variant is, in essence, a duplicate of your original raw file.
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Lens Correction
Use the Lens Correction tool to minimize chromatic aber-
ration, purple fringing, distortion, lightness and sharpness 
falloff. Make creative effects using the Vignetting tool.

Crop
The Crop tool enables freehand and fixed ratio crop op-
tions. It is even possible to crop outside the image area. 
Drag the crop mask in the Viewer to make composition 
adjustments at anytime during the editing process.
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Focus and Sharpening
Verify or modify the sharpness of the image. Always check 
sharpness at a 100% zoom view. First adjust the Radius 
and Amount sliders, and then alter Threshold value as 
required.

Local Adjustments 
The Local Adjustments tool tab allows you to create layers 
and adjust targeted areas of an image. Exposure, Sharpen-
ing, Clarity, Moiré and the Color Editor can also be applied 
to a Local Adjustment. The selected area is defined using a 
brush; you can adjust the hardness and size according to 
your editing needs. 
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Export
There are two export image options; Go to File>Export and 
choose either Originals or the Variant option. 

Export Originals lets you export original raw images with 
or without adjustments to a folder location on your com-
puter or external hard drive etc. (Check mark the ‘Include 
Adjustments’ option according to you preference). Press 
Export Original to complete the process.

Export Variants is a quick way to export a processed 
image. Go to the Store Files drop down menu and choose 
a location. Name your file, select a format and adjust the 
Quality slider as desired and press Export Variants to com-
plete the process.

Batch  
Go to the Batch tool tab to view images that are about to 
be processed. You can even reprocess images directly from 
the history tab as long as the original files are still available.
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DeutschCapture One 7 
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Capture One Pro 7 aktivieren
Befolgen Sie diese schrittweise Anleitung, um die Software 
Capture One Pro 7 zu aktivieren. Zur Durchführung der 
Aktivierung müssen Sie mit dem Internet verbunden sein.

1. Wählen Sie Capture One > Lizenz aus, um das Dialogfeld 
für die Lizenzaktivierung zu öffnen (siehe Abbildung).

2. Tragen Sie den Lizenzcode und die erforderlichen Anga-
ben zu Ihrem Profil ein. 

Den 16-stelligen Lizenzcode erhalten Sie entweder per 
E-Mail oder zusammen mit dem gelieferten Softwarepaket. 
Tragen Sie den Lizenzcode wie auf der Abbildung ein.

Geben Sie die E-Mail-Adresse ein, die in Ihrem Phase 
One-Konto gespeichert ist. Wenn noch kein Konto 
vorhanden ist, wird dieses für Sie erstellt. Klicken Sie auf 
‘Profil anfordern’. Daraufhin werden die restlichen Angaben 
automatisch eingetragen. Wenn Sie ein neuer Kunde sind, 
tragen Sie die restlichen Angaben bitte selbst ein. Klicken 
Sie anschließend auf die Schaltfläche ‘Aktivieren’.

3. Klicken Sie auf ‘Aktivieren’, um den Vorgang ab-

zuschließen. Die Software kann nun verwendet werden.

Fehlerbehebung
Wenn beim Umgang mit der Software Probleme auftreten, 
nutzen Sie eine der folgenden Hilferessourcen:

1. Lesen Sie das Benutzerhandbuch, das über das Hilfe-
menü aufgerufen werden kann. Alternativ steht im Internet 
unter http://help.phaseone.com eine umfassende Online-
Anleitung für die Software zur Verfügung.
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2. Unter www.youtube.com/PhaseOneDK stehen aktuelle 
Video-Lernprogramme zum Abruf bereit. 

3. Besuchen Sie www.phaseone.com/support, um Anre-
gungen und Unterstützung zu erhalten.

Erste Schritte
Die vorliegende Kurzanleitung soll Sie beim Einstieg in 
Capture One Pro 7 unterstützen. Unter der Internetadresse 
www.phaseone.com/7 erfahren Sie auf umfassende Weise, 
wie Sie die Software optimal nutzen können.

Die Benutzeroberfläche setzt sich aus vier Hauptbereichen 
zusammen (siehe Bildschirmabbildung unten):

1. Der Browser enthält unterschiedliche Miniaturansichten 
von Bildern sowie nützliche Funktionen zur Vereinfachung 
des Workflows, wie z.B. Bewertung, Benennung, Sortierung 
usw.

2. Im Viewer werden gewählte Bilder in hoher Qualität 
angezeigt. Sämtliche Änderungen an einem Bild werden in 
Echtzeit dargestellt.  

3. Die Werkzeugregister bieten Zugriff auf alle wesentlichen 
Werkzeuge für die Bildbearbeitung, wie z.B. Farbbalance, 
Belichtung und Schärfe.

4. Über Menü und Werkzeugleiste können systematisch 
Softwarefunktionen aufgerufen werden, die in der Anwend-
ung verfügbar sind.

Sitzungen
Wenn Sie bereits mit Sitzungen vertraut sind und diese Ar-
beitsweise bevorzugen, können Sie dies auch weiterhin tun:
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Hierbei erstellen Sie eine Sitzung als Projektcontainer, der 
in erster Linie Pfade zu Ordnern und Laufwerken speichert, 
die in einem Projekt verwendet werden. Für einen beschle-
unigten Zugriff können Sie die Speicherorte, die in einem 
bestimmten Projekt verwendet werden, als Favoritenordner 
festlegen.

Sitzungen sind besonders nützlich bei Aufnahmen mit 
angeschlossener Kamera (Tethering). Erstellen Sie hierzu 
einfach eine Tethering-Sitzung, verbinden Sie die Kamera 
mit dem Computer und nehmen Sie Fotos direkt in Capture 
One auf. Dies geht schneller als ein Bildimport nach der 
Aufnahme. Aufnahmen lassen sich sofort genau prüfen und 
die Bildeigenschaften können exakt angepasst werden.

Weitere Informationen finden Sie hier:
http://help.phaseone.com/en/CO6/Optimizing-Your-Work-
flow/Working-in-Sessions.aspx

Katalog erstellen
Alternativ zu Sitzungen können Sie mit Katalogen arbeiten.

In Capture One Pro 7 werden primär Kataloge zur Organi-
sation und Anzeige von Dateien verwendet. Ein Katalog 
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enthält alle von Capture One Pro 7 benötigten Informa-
tionen, um zum Katalog hinzugefügte Bilder zu finden und 
anzeigen zu können. 

Dazu zählen Angaben zur Organisation der Bilder im Kata-
log, Metadaten und ausgeführte Anpassungen an Bildern.

Die eigentlichen Bilddateien können an einem beliebigen 
Speicherort auf einem Datenträger oder direkt in der Kata-
logdatei abgelegt werden. Über das Werkzeug Bibliothek 
werden Bilddateien gesucht und geöffnet. Bilddateien müs-
sen in einen Katalog importiert werden. Ein Katalog kann 
ebenfalls per unterstützter angeschlossener Kamera direkt 
mit Bilddateien befüllt werden. 

1. Um einen Katalog zu erstellen, wählen Sie Datei > Neuer 
Katalog... aus. 

2. Daraufhin erscheint ein Dialogfeld. Weisen Sie dem Kata-
log einen Namen zu und wählen Sie einen Speicherort aus.

Bilder importieren
Erstellen Sie vor einem Bildimport zunächst einen Katalog 
oder eine Sitzung. Rufen Sie dazu Datei > Neuer Katalog 

oder Neue Sitzung auf. Füllen Sie das Feld Name aus, 
wählen Sie einen Speicherort aus und klicken Sie auf OK.

Es bestehen drei grundlegende Möglichkeiten, Bilddateien 
zu importieren: 

1. Verbinden Sie einen Kartenleser mit dem Computer 
und legen Sie eine Speicherkarte ein. Capture One öffnet 
daraufhin automatisch das Importfenster. 
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2. Importieren Sie Dateien vom Computer oder von einer 
externen Festplatte, indem Sie Datei > Bilder impor-
tieren... auswählen. Wählen Sie unter Speicherorte in der 
Dropdown-Liste ‘Von’ einen Ordner aus, der RAW-Dateien 
enthält. 

Das Dialogfeld ‘Bilder importieren’ enthält eine Reihe von 
Automatisierungsoptionen, die je nach Anforderungsprofil 
Ihres Workflows ausgewählt werden können. Dazu zählt 
eine Sicherungsfunktion für Bilddateien, eine Benennungs-
funktion sowie die Möglichkeit, eine Bildunterschrift und 
Hinweise zum Urheberrecht hinzuzufügen.

3. Verbinden Sie eine unterstützte Kamera oder ein 
Digitalrückteil direkt mit dem Computer (Tethering). Auf-
genommene Bilder werden standardmäßig zum aktiven 
Katalog bzw. zur aktiven Sitzung hinzugefügt. 

Aufnehmen
Das Werkzeugregister Aufnehmen ermöglicht ein Tethering, 
also das Erstellen von Aufnahmen mit einem Phase One-
Digitalrückteil oder anderen unterstützten Kameras, die direkt 
mit dem Computer verbunden sind. Verbinden Sie dazu eine 
Kamera per FireWire- oder USB-Kabel mit dem Computer. 

Dieses Werkzeugregister enthält zahlreiche Funktionen zur 
Optimierung Ihres Workflows. Die Belichtungseinstellungen 
für die Kamera können per Software festgelegt werden. 
Bildanpassungen und unterschiedliche Stile lassen sich 
direkt bei der Aufnahme anwenden. Mit dem Werkzeug 
Kamera ändern Sie ISO- und Weißabgleichseinstellungen. 
Außerdem kann der Auslöser einer angeschlossenen Kam-
era betätigt bzw. deren Live View-Modus aktiviert werden. 

Mithilfe des Werkzeugs bzw. der App Capture Pilot verbin-
den Sie Capture One Pro 7 mit einem iPad, iPod Touch 
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und iPhone. Mit der App Capture Pilot sind Sie in der Lage, 
Bilddateien auf einem iOS-Gerät anzuzeigen, zu bewerten 
und aufzunehmen.  

Das Werkzeug Capture Pilot besitzt außerdem eine Intern-
etanbindung. So können Sie Aufnahmen per Webbrowser 
darstellen, bewerten und mit Farbmarkierungen versehen. 
Dies funktioniert auf einem Computer, einem Android-
Mobilgerät oder auf einem Gerät mit Windows Phone-
Betriebssystem.   

Farbe
Capture One bietet eine Reihe von Werkzeugen für die Far-
banpassung. Diese Werkzeuge unterstützen Ihren Workflow 
beim Bearbeiten spezieller Parameter wie Weißabgleich 
oder Hautton. 

Das Werkzeugregister Farbe und die enthaltenen Funk-
tionen sollten stets das Kernstück Ihres Workflows bei der 
Bildbearbeitung darstellen. Mit dem Farbeditor können Sie 
ein begrenztes Farbspektrum auswählen und anpassen, 
ohne die übrigen Farben in einem Bild zu beeinflussen. 
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Tipp: Um neutrale Farben zu erhalten, erstellen Sie bei der 
Fotosession ein Testbild mit einer Graukarte. 

Belichtung
Das Capture One-Werkzeug für die Belichtung ermöglicht 
die Einstellung von Belichtung, Kontrast, Helligkeit und 
Sättigung. 

Das Werkzeug HDR empfiehlt sich für Bilder mit extremen 
Lichtern und stark ausgeprägten Tiefen. Die Werkzeuge 
Tonwerte und Gradationskurven erlauben eine Feinabstim-
mung der Belichtung. Mit den Schiebereglern für Klarheit 
verleihen Sie einer Aufnahme mehr Pepp. 
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Bilder bearbeiten
Nutzen Sie bei der Bildbearbeitung die Funktion Varianten, 
um sich eine Bildvorschau mit angewandten Anpassungen 
anzeigen zu lassen. Die Funktion Varianten macht es leicht, 
mit verschiedenen Bildanpassungen zu experimentieren. 

Mit der Taste F3 bzw. F7 (Mac/PC) erhalten Sie eine ex-
akte Kopie (geklonte Variante) eines ausgewählten Bilds. 
(Alternativ können Sie den Befehl Bild > Variante klonen 
verwenden.) Die neue Variante ist im Grunde ein Duplikat 
der RAW-Originaldatei.

Objektivkorrektur
Mithilfe des Werkzeugs Objektivkorrektur lassen sich chro-
matische Aberrationen, violette Farbsäume, Verzeichnungen 
sowie Helligkeits- und Schärfeabfall minimieren. Mit dem 
Werkzeug Vignettierung können Sie kreative Effekte erzielen.
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Zuschneiden
Das Werkzeug Zuschneiden ermöglicht einen Bildbeschnitt 
mit einem freien oder fest vorgegebenen Seitenverhältnis. 
Es ist außerdem möglich, einen Zuschnitt außerhalb des 
Bildbereichs vorzunehmen. Die Zuschneidemaske lässt sich 
in den Viewer ziehen, damit Sie die Bildkomposition bei der 
Bearbeitung jederzeit anpassen können.

Fokus und Schärfung
Überprüfen oder ändern Sie die Bildschärfe. Die Schärfe 
sollte stets in der 100%-Ansicht geprüft werden. Passen 
Sie zunächst die Schieberegler Stärke und Radius an. Just-
ieren Sie danach den Schwellenwert je nach Bedarf.
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Lokale Anpassungen
Auf dem Werkzeugregister Lokale Anpassungen können 
Sie Ebenen erstellen und ausgewählte Bildbereiche gezielt 
bearbeiten. Belichtung, Schärfung, Klarheit, Moiré und 
Farbeditor lassen sich ebenfalls auf eine lokale Anpassung 
anwenden. Der Auswahlbereich wird per Pinsel festgelegt. 
Dafür können je nach Bearbeitungsanforderung Stärke und 
Größe festgelegt werden. 

Export
Für den Bildexport sind zwei Optionen verfügbar. Rufen Sie 
Datei > Exportieren auf und wählen Sie die Option ‘Origi-
nale’ oder ‘Variante’ aus. 

Mit der Option Originale exportieren können Sie ur-
sprüngliche RAW-Dateien mit oder ohne Anpassungen in 
einen Ordner auf dem Computer oder auf einer externen 
Festplatte usw. exportieren. (Aktivieren oder deaktivieren 
Sie je nach Wunsch das Kontrollkästchen ‘Anpassungen 
einschließen’.) Klicken Sie auf ‘Original exportieren’, um den 
Vorgang abzuschließen.
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Mit der Option Varianten exportieren lassen sich bearbe-
itete Bilder schnell exportieren. Wählen Sie im Dropdown-
Menü Dateiablage einen Speicherort aus. Geben Sie einen 
Namen für die Datei ein, wählen Sie ein Format aus und 
passen Sie den Schieberegler für die Qualität an. Klicken 
Sie auf ‘Varianten exportieren’, um den Vorgang ab-
zuschließen.

Stapel
Das Werkzeugregister Stapel enthält Bilddateien, die sich in 
der Verarbeitungswarteschlange befinden. Sofern die Origi-
naldateien noch verfügbar sind, können Sie Bilder direkt 
über das Register ‘Verlauf’ erneut bearbeiten.
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The results are like upgrading one or two entire 
camera generations, adding 50% new pixels to your 
camera and 3 stops of ISO capability – amazing.

Quote by Photographer Jack Flesher

”

”
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Activation de Capture One Pro 7
Ce guide explique comment activer le logiciel Capture One 
Pro 7. L’activation exige une connexion Internet.

1. Sélectionnez Capture One>Licence... pour ouvrir la boîte 
de dialogue d’activation, comme dans l’illustration.

2. Saisissez le code de licence et les informations du profil. 

Vous avez reçu un code de licence à 16 caractères par 
e-mail ou vous l’avez trouvé dans le coffret du logiciel. 
Saisissez le code de licence, comme illustré.

Saisissez l’adresse e-mail correspondant à votre compte 
Phase One. Si vous n’avez pas de compte, le système en 
crée un automatiquement. Cliquez sur « Obtenir un profil ». 
Le reste du formulaire est rempli automatiquement. Si vous 
êtes un nouveau client, remplissez le reste du formulaire, 
puis cliquez sur le bouton « Activer ».

3. Enfin, cliquez sur « Terminé ». Votre logiciel est prêt à 
l’emploi

Dépannage
En cas de problème lors de l’utilisation du logiciel, procé-
dez comme suit:

1. Lisez le Guide de l’utilisateur accessible via le menu 
d’aide, ou consultez le guide en ligne complet sur http://
help.phaseone.com.

2. Visionnez les vidéos tutorielles sur www.youtube.com/
PhaseOneDK. 
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3. Besoin d’une source d’inspiration et de conseils? 
Rendez-vous sur www.phaseone.com/support.

Démarrage
Ce guide vous aide à vous familiariser avec Capture One 
Pro 7. Pour savoir comment exploiter pleinement les fonc-
tions du logiciel, rendez-vous sur www.phaseone.com/7.

L’ interface utilisateur comprend quatre sections illustrées 
dans la capture d’écran ci-dessous:

1. Le navigateur, qui propose différents affichages des 
vignettes et de nombreuses fonctions: notation, nommage, 
tri, etc.

2. La fenêtre principale, qui affiche l’image sélectionnée 
dans un rendu de grande qualité. Toutes les modifications 
apportées à l’image s’affichent instantanément.  

3. Les onglets Outils, qui donnent accès aux principaux 
outils nécessaires pour retoucher les images: balance des 
couleurs, exposition, netteté, etc.

4. Le menu et la barre d’outils, qui permettent d’accéder de 
manière structurée aux fonctionnalités de l’application.

Sessions
Si vous connaissez la méthode des sessions et préférez 
vous y tenir, vous en avez la possibilité:
Créez une « session », c’est-à-dire un conteneur « projet » 
stockant les emplacements des dossiers et leurs chemins 
d’accès sur les lecteurs affectés au projet en question. Pour 
accéder rapidement à un dossier, vous pouvez l’ajouter à 
vos favoris liés aux emplacements affectés au projet cor-
respondant.
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Les sessions sont d’une grande utilité en prise de vues en 
mode connecté. Il suffit de créer une session « connectée » 
et de brancher l’appareil. Les photos prises sont envoyées 
directement à Capture One. Le gain de temps par rapport à 
l’importation des images au terme d’une prise de vues est 
important. Les vues peuvent être examinées en temps réel, 
ce qui facilite l’affinage des paramètres d’image.

Pour plus d’information à ce propos, rendez vous sur: 
http://help.phaseone.com/en/CO6/Optimizing-Your-Work-
flow/Working-in-Sessions.aspx

Création d’un album
Outre les sessions, un autre mode de travail repose sur les 
albums.

L’« album » est le principal mode d’organisation et de 
visualisation des fichiers sous Capture One Pro 7. Toute 
l’information nécessaire au logiciel pour localiser et afficher 
toute image placée dans l’album est regroupée dans ce 
dernier. 

Il s’agit du mode d’organisation des images dans l’album, des 
métadonnées et même des retouches appliquées à l’image.
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Les fichiers image peuvent être stockés sur un lecteur 
quelconque, mais peuvent aussi être stockés dans le fichier 
de l’album.  La localisation et la visualisation des fichiers 
image se font via l’outil Bibliothèque. Les fichiers image 
doivent être importés dans un album. Il est aussi possible 
d’envoyer directement vers un album les photos prises en 
mode connecté. 

1 Créez un catalogue en sélectionnant Fichier>Nouvel 
album... 

2. Une boîte de dialogue s’affiche. Nommez l’album dans le 
champ prévu à cet effet et sélectionnez son emplacement.

Importation d’images
Avant toute chose, créez un album ou une session. Sélec-
tionnez Fichier>Nouvel album ou Nouvelle session. Nom-
mez l’album ou la session dans le champ prévu à cet effet, 
sélectionnez son emplacement et cliquez sur OK.

Il existe trois façons de procéder pour importer des fichiers 
image: 

1. Connectez un lecteur de carte à votre ordinateur et insé-
rez votre carte mémoire. Capture One ouvre automatique-
ment la fenêtre d’importation. 

2. Importation de fichiers à partir d’un ordinateur ou d’un 
disque dur externe en sélectionnant Fichier>Importer les 
images... Recherchez et sélectionnez le dossier contenant 
les images voulues à l’aide du menu déroulant « Emplace-
ments ». 
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La boîte de dialogue « Importer les images » comprend 
diverses options automatisées à sélectionner en fonction 
de vos préférences. Ces options comprennent un outil de 
sauvegarde (« Backup »), une fonction de nommage des 
fichiers et des champs permettant d’ajouter une légende et 
des données de copyright (métadonnées).

3. Prise de vues en mode connecté avec un reflex numé-
rique (DSLR) ou dos numérique compatible. Par défaut, les 
images sont envoyées vers l’album actif/la session active. 

Capturer
L’onglet Outil capturer permet une prise de vue en mode 
connecté à l’aide d’un dos numérique Phase One ou d’un 
DSLR compatible. Raccordez l’appareil photo à votre ordi-
nateur à l’aide d’un câble FireWire ou USB. 

Cet onglet met à votre disposition de nombreuses fonctions 
utiles,  dont le réglage à distance de l’appareil photo et 
l’application de réglages et de styles multiples lors de la 
prise de vues. L’outil Appareil permet de modifier les para-
mètres ISO et Balance des blancs, de déclencher l’appareil 
connecté ou d’activer sa fonctionnalité Visée vidéo. 

L’outil/onglet Capture pilote permet de connecter Capture 
One Pro 7 à un iPad, iPod Touch ou iPhone. L’application 
Capture pilote vous permet de présenter, de noter et de 
capturer des fichiers image sur un appareil iOS.  

L’outil Capture pilote comporte par ailleurs une fonction 
Internet permettant de visualiser, de noter et de marquer 
à l’aide d’une balise couleur les images en provenance du 
navigateur Internet d’un ordinateur, d’un appareil mobile 
Android ou du système d’exploitation Windows Phone.   
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Couleur
Capture One comprend divers outils de réglage des 
couleurs. Ces outils vous facilitent la tâche par rapport à 
des aspect spécifiques tels que la balance des blancs et les 
tons chair. 

C’est sur l’onglet Couleur et ses fonctionnalités que repose 
tout le volet retouche d’image de votre travail. L’Éditeur de 
couleurs permet de sélectionner et d’ajuster un spectre 
étroit sans modifier les autres couleurs de l’image. 
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Conseil : pour vous donner une référence, photographiez 
une charte gris neutre. 

Exposition
Outre l’exposition, cet outil permet de régler le contraste, la 
luminosité et la saturation. 

L’outil Image large dynamique permet de retoucher des 
images très contrastées. Les puissants outils Niveaux et 
Courbe affinent l’exposition ou rendent l’image plus percu-
tante grâce aux curseurs « Clarté ». 
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Modification des images
Pour retoucher vos images, testez la fonction Variante, qui 
permet de visualiser plusieurs réglages. 

Appuyez sur F3/F7 (Mac/PC) pour dupliquer l’image sélec-
tionnée. (Vous pouvez aussi sélectionner Image>Dupliquer 
variante.) La « variante » ainsi créée est une copie de votre 
fichier image d’origine.

Objectif
L’outil Objectif permet de réduire les aberrations chro-
matiques, les franges pourpres, les déformations, et 
l’affaiblissement de la lumière et de la netteté. L’outil 
Vignettage permet d’appliquer des effets créatifs.
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Composition
L’outil Composition permet de modifier le format de l’image 
à main levée ou par incréments fixes. Le recadrage est 
même possible hors du cadre de l’image. Vous pouvez faire 
glisser le masque de cadrage dans la fenêtre principale 
pour modifier la composition à tout moment.

Détails
Permet de vérifier et de modifier la netteté de l’image. 
Vérifiez toujours la netteté en affichage 100 %. Commencez 
par régler les curseurs Rayon et Montant avant de passer à 
la valeur Seuil.
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Réglages locaux 
L’onglet Réglages locaux permet de créer des calques et 
de modifier des zones précises de l’image. Les outils Ex-
position, Accentuation, Clarté, Moiré et Éditeur de couleurs 
sont accessibles via cet onglet. La zone sélectionnée se 
définit à l’aide d’un « pinceau » dont la dureté et la taille 
sont réglables à volonté. 

Exportation
Le programme vous propose deux options d’exportation 
des images : sélectionnez Fichier>Exporter et choisissez 
l’option Originaux ou Variantes. 

Exporter originaux vous permet d’exporter les images 
brutes originales, modifiées ou non, vers un dossier situé 
sur votre ordinateur, un disque dur externe, etc. (Cochez la 
case « Inclure réglage » si nécessaire.) Cliquez sur Exporter 
originaux pour terminer.
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Exporter variantes permet d’exporter rapidement une 
image après retouche. Dans le menu déroulant Stockage 
fichiers, sélectionnez l’emplacement. Nommez votre fichier, 
sélectionnez un format, réglez le curseur Qualité et cliquez 
sur Exporter variantes pour terminer.

Lot  
Sélectionnez l’onglet Lot pour visualiser les images à 
retoucher. Vous pouvez retoucher à partir de l’onglet His-
torique toute image déjà traitée dont le fichier original est 
toujours disponible.
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I love the software and am using it every day.
I get the best results using Capture One Pro 7
by far, when comparing with any other software.
My complete digital workflow relies on Capture
One Pro 7. Could not do without it.

Quote by Photographer Andreas Bitesnich
”

”
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Capture One 7 
the professional choice in imaging software
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Attivazione di Capture One Pro 7
Leggi la presente guida passo dopo passo su come attivare 
il software Capture One Pro 7. Per completare l’attivazione 
è necessario essere connessi ad Internet.

1. Dal menu Capture One selezionare Licenza... per aprire la 
finestra di dialogo Attivazione licenza (come illustrato).

2. Inserire il codice di licenza e le informazioni sul profilo. 

Il codice di licenza è costituito da 16 caratteri ed è fornito 
via e-mail o con la confezione originale del software. 

Digitare il codice di licenza come illustrato. Digitare 
l’indirizzo e-mail relativo al proprio account Phase One; se 
non si possiede un account, ne verrà creato uno. Premendo 
“Ottieni profilo” verranno compilati in automatico i campi 
restanti del modulo. Se si è un nuovo utente, compilare i 
campi restanti del modulo. Successivamente fare clic su 
“Attiva”.

3. Completa la procedura con un clic su “Attiva”. Ora il 
software è pronto per l’uso.

Risoluzione dei problemi
Se si riscontrano dei problemi con il software, consultare 
una delle seguenti risorse:

1. Leggi la Guida Utente contenuta nel menu Aiuto o Ac-
cedi direttamente al sito http://help.phaseone.com, guida 
globale online di assistenza al software

2. Guarda gli ultimi video tutorial su www.youtube.com/
PhaseOneDK.
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3. Consulta il sito www.phaseone.com/support per trarre 
ispirazione e risolvere i problemi.

Guida introduttiva
Il presente documento è una guida introduttiva al software 
Capture One Pro 7. 
Consulta il sito www.phaseone.com/7 per informazioni  
dettagliate su come ottenere il massimo dal software.

L’interfaccia utente è costituita da quattro aree operative 
come illustrato nella seguente schermata:

1. Nel Browser sono visualizzate diverse viste di miniature 
di immagini nonché alcune funzioni utili per un flusso di 
lavoro più agevole, fra cui classificazione delle immagini, 
denominazione dei file, ricerca e filtri e tante altre.

2. Il Visualizzatore fornisce una resa di elevata qualità 
dell’immagine selezionata.  Tutte le modifiche applicate 
all’immagine verranno visualizzate istantaneamente.  

3. I Pannelli Strumenti consentono di accedere agli  
strumenti principali necessari per elaborare le immagini, ad 
es. il bilanciamento colori, l’esposizione e la nitidezza.

4. La barra dei Menu e la barra degli Strumenti offrono un 
accesso strutturato alle funzioni e alle caratteristiche del 
software contenute nell’intera applicazione.

Sessioni
Se si è già in grado e si preferisce continuare a lavorare con 
le sessioni, è possibile procedere come indicato di seguito:

Crea una Sessione la quale funzionerà da contenitore del 
progetto in cui archiviare principalmente la destinazione 
delle cartelle e i percorsi alle unità utilizzate in un progetto. 
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Per accedere e caricare rapidamente le cartelle è possibile 
creare delle cartelle di preferiti per le posizioni utilizzate in 
un dato progetto.

Le sessioni si rivelano particolarmente utili quando si  
seguono scatti cablati. 
È sufficiente creare una sessione cablata, collegare una 
fotocamera e acquisire le immagini direttamente in  
Capture One. Ciò consente un notevole risparmio di  
tempo rispetto all’importazione delle immagini dopo uno 
scatto. Uno scatto può essere analizzato in dettaglio nel 
momento stesso in cui viene eseguito, per poter regolare 
finemente i parametri dell’immagine.

Per maggiori informazioni, vedere:  http://help.phaseone.
com/en/CO6/Optimizing-Your-Workflow/Working-in- 
Sessions.aspx

Creazione di un catalogo
In alternativa al lavoro in sessioni è possibile organizzare il 
lavoro in cataloghi.

Il catalogo rappresenta il metodo principale per organiz-
zare e visualizzare i file in Capture One Pro 7. Il catalogo 
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contiene tutte le informazioni necessarie a Capture One  
Pro 7 per trovare e visualizzare qualsiasi immagine aggiunta 
al catalogo. 

Le informazioni specificano ad esempio come sono state 
organizzate le immagini nel catalogo, i metadati e persino 
quali regolazioni visive sono state applicate alle immagini.

La posizione dei file delle immagini correnti può essere in 
qualsiasi parte del disco oppure all’interno del file di cata-
logo stesso. I file di immagine si trovano nello strumento 
Libreria da cui è possibile accedervi. I file di immagine 
devono essere importati in un catalogo. Inoltre è possibile 
acquisire direttamente le immagini in un catalogo da una 
fotocamera cablata supportata. 

1 Per creare un catalogo scegliere File>Nuovo catalogo... 

2. Verrà visualizzata una finestra di dialogo. Compilare il 
campo Nome e scegliere un percorso per il catalogo.

Importazione delle immagini
Prima di importare le immagini, è necessario creare un 
nuovo catalogo o una sessione. Fare clic su File>Nuovo 

catalogo o Nuova sessione. Compilare il campo Nome, 
scegliere un percorso e fare clic su OK.

Per importare i file immagine vi sono tre modalità principali: 

1. Collegare un lettore di schede al computer ed inserire 
una scheda di memoria. Capture One aprirà automatica-
mente la finestra di dialogo di importazione. 
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2. Importare i file dal proprio computer o da un disco fisso 
esterno scegliendo File>Importa immagini... Navigare e  
selezionare una cartella contenente immagini RAW dal 
menu a tendina Percorso. 

La finestra di dialogo Importa Immagini contiene svariate 
opzioni automatiche selezionabili in base alle proprie  
preferenze di flusso di lavoro, fra cui uno strumento di 
backup immagini, denominazione file e campi per  
aggiungere didascalie e informazioni di copyright.

3. Acquisire uno scatto cablato da una fotocamera DSLR 
supportata o da un Dorso Digitale. 
Le immagini verranno importate come impostazione di  
base nel Catalogo/ Sessione attiva. 

Acquisizione
Il pannello strumenti Acquisisci funziona da porta di ac-
cesso all’acquisizione cablata degli scatti da un dorso 
digitale Phase One o da una fotocamera DSLR supportata. 
Collega una fotocamera al computer utilizzando un cavo 
FireWire o USB. 

Questo pannello strumenti include numerose funzioni per 

un flusso di lavoro più agevole. 
È possibile regolare in remoto le impostazioni di espo-
sizione della fotocamera, applicare regolazioni e molteplici 
stili durante l’acquisizione. Lo strumento Fotocamera con-
sente di modificare le impostazioni ISO e Bilanciamento del 
Bianco e attivare l’otturatore di una fotocamera collegata o 
attivare la funzione Live View. 

Utilizzare lo strumento/applicazione Capture Pilot per con-
nettere Capture One Pro 7 a un iPad, iPod Touch e iPhone. 
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L’applicazione Capture Pilot consente di presentare, clas-
sificare e acquisire file immagine da un dispositivo iOS.  

Capture Pilot ha inoltre una funzione web grazie alla quale 
è possibile visualizzare, classificare e assegnare dei tag 
colore a delle immagini acquisite tramite un browser web 
su un computer o un sistema operativo Android (dispositivo 
mobile) o Windows Phone.
   

Colore
Capture One offre una serie di strumenti per la regolazione 
dei colori. Gli strumenti sono concepiti per supportare il 
flusso di lavoro durante la gestione di argomenti specifici 
quali il bilanciamento del bianco e l’incarnato. 

Il pannello strumenti Colore e le relative funzioni dovreb-
bero costituire il fulcro del proprio lavoro di regolazione 
di immagini. Grazie all’Editor Colori, gli utenti possono 
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selezionare e regolare uno spettro ristretto di colori senza 
conseguenze sugli altri colori dell’immagine. 

Suggerimento: per ottenere i colori neutri, acquisire uno 
scatto di prova con una scheda grigia durante lo scatto 
fotografico.

Esposizione
Usa lo strumento Esposizione di Capture One per regolare 
l’esposizione, il contrasto, la luminosità e la saturazione. 

Prova lo strumento High Dynamic Range per recuperare 
informazioni nelle alte luci e ombre. Utilizza gli efficaci  
strumenti Livelli e Curve per regolare le esposizioni o 
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perfezionare le immagini con le barre di scorrimento dello 
strumento Chiarezza.  

Modifica delle immagini
Prova la funzione Varianti durante la modifica di immagini per 
visualizzare un’anteprima dell’immagine selezionata con le 
stesse regolazioni applicate. Utilizza la funzione Varianti per 
sperimentare varie regolazioni dell’immagine. 
Premi F3/F7 (Mac/PC) per ottenere una Variante Duplicata 
dell’immagine selezionata. 

(In alternativa, scegliere Immagine>Nuova Variante). La nuo-
va variante è, in pratica, un duplicato del file RAW originale.

Correzione obiettivo
Utilizza lo strumento Correzione Obiettivo per affrontare 
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diversi problemi, quali l’aberrazione cromatica, gli aloni 
viola, la distorsione, le cadute di luce e nitidezza. Utilizza lo 
strumento Vignettatura per giocare con effetti creativi.

Ritaglio
Lo strumento Ritaglio attiva le opzioni di ritaglio libero e 
rapporto fisso di ritaglio. 
È possibile ritagliare anche al di fuori dell’area ell’immagine. 
Trascinare la maschera di ritaglio nel visualizzatore per 

effettuare delle regolazioni di composizione in qualsiasi 
momento durante il processo di modifica.

Messa a fuoco e nitidezza
Per verificare o modificare la nitidezza dell’immagine.Veri-
fica sempre la nitidezza con lo zoom impostato su 100%. 
Innanzitutto regolare i dispositivi di scorrimento Raggio e 
Quantità, quindi modificare il valore Soglia secondo neces-
sità.100%. Innanzitutto regolare i dispositivi di scorrimento 
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Raggio e Quantità, quindi modificare il valore Soglia sec-
ondo necessità.

Regolazioni locali 
Lo strumento Regolazioni Locali consente di creare livelli e 
di lavorare su aree specifiche dell’immagine. Anche gli stru-
menti Esposizione, Nitidezza, Chiarezza, Moiré ed Editor 
Colori possono essere applicati ad una Regolazione Locale. 
L’area selezionata viene definita per mezzo di un cursore 

pennello, la cui dimensione e durezza possono essere 
impostate in base alle proprie esigenze di modifica. 

Elaborazione
Le opzioni per elaborare le immagini sono due; selezionare 
File>Esporta e scegliere l’opzione Originale o Variante.  

Elabora Originale consente di elaborare immagini originali 
RAW con o senza regolazioni in una cartella sul computer o 
su un disco fisso esterno ecc. 
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(Seleziona l’opzione “Includi Regolazioni” in base alle  
proprie preferenze). 
Premi Elabora Originale per completare il processo.

Elabora Variante consente di elaborare rapidamente 
un’immagine modificata. 
Apri il menu a tendina Archivia File e scegli una  
destinazione. 

Digita un nome per il file, seleziona un formato e regola a 
piacere la barra di scorrimento Qualità, quindi fai clic su 
Elabora Variante per completare il processo.

Batch  
Con il pannello strumenti Batch è possibile visualizzare la 
coda di elaborazione delle immagini. 
Inoltre è possibile rielaborare delle immagini direttamente 
dalla cronologia sempre che i file originali siano ancora 
disponibili.
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You can really see a difference with the version 7 
processing engine. Now I want to re-process
everything from the past year. Capture One Pro 7
blows away version 6 and competition.

Quote by Photographer Jaime Demarco

”
”
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Capture One 7 
the professional choice in imaging software
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Activación de Capture One Pro 7
Siga esta guía paso a paso para activar el software Capture 
One Pro 7. Para poder finalizar la activación es necesario 
estar conectado a Internet.

1. Vaya a “Capture One” > “Licencia...” para abrir el cuadro 
de diálogo de activación de la licencia, tal como se ilustra.

2. Introduzca el código de licencia y los detalles del perfil. 

Recibirá el código de licencia de 16 caracteres por correo 
electrónico o en el paquete de software original. Escriba el 
código de licencia, tal como se ilustra.

Escriba la dirección de correo electrónico asociada a su 
cuenta Phase One. Si no tiene ninguna cuenta, se creará 
una para usted. Pulse el botón “Obtener perfil”, y el resto 
del formulario se rellenará automáticamente. Si es un cli-
ente nuevo, rellene el resto del formulario. A continuación, 
pulse el botón “Activar”.

3. Finalice el proceso haciendo clic en “Activar”, y el soft-
ware estará listo para su uso.

Solución de problemas
Si tiene algún problema con el software, pruebe alguna de 
las soluciones siguientes:

1. Lea la guía de usuario que se encuentra en el menú 
“Ayuda” o vaya directamente a http://help.phaseone.com 
para acceder a una guía online exhaustiva del software.

2. Vea los tutoriales en vídeo más recientes en www.you-
tube.com/PhaseOneDK. 
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3. Visite www.phaseone.com/support para inspirarse y 
solucionar problemas.

Introducción
Esta guía es una introducción a Capture One Pro 7. Visite el 
sitio www.phaseone.com/7 para obtener información deta-
llada sobre cómo sacar el máximo partido al software.

Como puede verse en la captura de pantalla siguiente, la 
interfaz de usuario consta de cuatro secciones principales.

1. En el explorador se muestran distintas vistas de imá-
genes en miniatura. Esta sección también consta de prác-
ticas funciones que facilitan el flujo de trabajo, por ejemplo, 
calificación, asignación de nombres, clasificación, etc.

2. El visor contiene una representación de alta calidad de la 
imagen seleccionada. Todos los cambios efectuados en la 
imagen se muestran de inmediato.

3. Las fichas de herramientas permiten acceder a todas 
las herramientas fundamentales necesarias para editar 
imágenes, por ejemplo, balance de color, exposición y 
definición.

4. A través de la barra de menús y herramientas se puede 
acceder de forma estructurada a las funciones y presta-
ciones de software incluidas en la aplicación.

Sesiones
Si ya está familiarizado con este sistema y prefiere seguir 
trabajando con sesiones, puede hacerlo.

Cree una sesión para utilizarla como contenedor de proyec-
tos que almacene principalmente ubicaciones de carpetas 
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y rutas a las unidades empleadas en un proyecto. Para 
abrir y cargar carpetas rápidamente puede crear carpetas 
favoritas para las ubicaciones utilizadas en un proyecto en 
concreto.

Las sesiones resultan especialmente útiles cuando se 
trabaja conectado al ordenador. Solo tiene que crear una 
sesión con conexión al ordenador, conectar la cámara 
y capturar las imágenes directamente en Capture One. 
Así, tardará menos tiempo que importando las imágenes 
después de tomarlas. Es posible examinar las capturas 
a medida que se producen, lo que le ayudará a definir en 
detalle los parámetros de cada imagen.

Para obtener más información, visite el sitio http://help.
phaseone.com/es-ES/CO6/Optimizing-Your-Workflow/
Working-in-Sessions.aspx.

Creación de un catálogo
La alternativa al trabajo con sesiones es el trabajo con 
catálogos.

Un catálogo es el método principal de organización y visu-
alización de archivos en Capture One Pro 7. Un catálogo 
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contiene toda la información necesaria para que Capture 
One Pro 7 encuentre y muestre cualquier imagen agregada 
al catálogo. 

En esta información se incluye el modo en el que están 
organizadas las imágenes en el catálogo, metadatos e 
incluso los ajustes visuales efectuados en las imágenes.

Los archivos de imagen reales pueden estar ubicados en 
cualquier disco, pero también pueden estar ubicados den-
tro del propio archivo de catálogo. Los archivos de imagen 
se buscan y se abren desde la herramienta “Biblioteca”. 

Los archivos de imagen deben importarse en un catálogo. 
También es posible capturar una fotografía directamente 
en un catálogo desde una cámara compatible conectada al 
equipo informático. 

1. Cree un catálogo seleccionando “Archivo” > “Nuevo 
catálogo...”. 

2. Aparecerá un cuadro de diálogo. Rellene el campo 
“Nombre” y seleccione una ubicación para el catálogo.

Importación de imágenes
Antes de importar imágenes, primero hay que crear una 
sesión o un catálogo nuevo. Vaya a “Archivo” > “Nuevo 
catálogo” o “Nueva sesión”. Rellene el campo “Nombre”, 
seleccione una ubicación y pulse “Aceptar”.

Hay tres métodos principales para importar archivos de 
imagen: 
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1. Conectar un lector de tarjetas al equipo e insertar una 
tarjeta de memoria; Capture One abrirá la ventana de im-
portación automáticamente. 

2. Importar los archivos desde el equipo o un disco duro 
externo seleccionando “Archivo” > “Importar imágenes...”; 
desde el menú desplegable “Ubicación” se busca y se 
selecciona una carpeta que contenga imágenes en formato 
RAW. 

El cuadro de diálogo “Importar imágenes” tiene una serie 
de opciones automatizadas que se pueden seleccionar de 
acuerdo con la preferencia de flujo de trabajo, entre ellas, 
una herramienta de copia de seguridad de imágenes, una 
funcionalidad para asignar nombres a los archivos y cam-
pos para agregar información de captura y copyright.

3. Trabajar conectado al ordenador desde una cámara 
DSLR o desde un respaldo digital compatibles; las 
imágenes se guardarán de forma predeterminada en el 
catálogo o la sesión activos. 

Captura
La ficha de la herramienta “Captura” es la puerta de entra-
da a la captura con conexión a ordenador con un respaldo 
digital Phase One o una cámara DSLR compatible. Conecte 
una cámara al equipo mediante un cable USB o FireWire. 

Esta ficha de herramienta tiene multitud de funciones 
que facilitan el flujo de trabajo. Configure los ajustes de 
exposición de la cámara de forma remota o aplique ajustes 
y múltiples estilos durante la captura. Utilice la herramienta 



65

Español

“Cámara” para modificar los ajustes “ISO” y “Balance de 
blancos” y disparar el obturador de una cámara conectada 
o activar la funcionalidad “Función vídeo” de la cámara. 

Utilice la herramienta/aplicación Capture Pilot para conec-
tar Capture One Pro 7 a un iPad, iPod Touch o iPhone. 
La aplicación Capture Pilot permite presentar, calificar y 
capturar archivos de imagen en un dispositivo iOS.

La herramienta Capture Pilot también tiene una función 
web que permite visualizar, calificar y etiquetar por colores 
imágenes capturadas desde un explorador web en un 
sistema operativo Windows Phone, Android (dispositivo 
móvil) o PC. 

Color
Capture One ofrece una serie de herramientas para ajustar 
los colores. Estas herramientas están diseñadas para facili-
tar el flujo de trabajo a la hora de tratar aspectos específi-
cos como el balance de blancos o el tono de piel. 
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La ficha de la herramienta “Color” y su funcionalidad de-
berían ser siempre la piedra angular del flujo de trabajo de 
edición de imágenes. El “Editor de color” permite a los usu-
arios seleccionar y ajustar un espectro cromático estrecho 
sin afectar a los demás colores de una imagen. 

Consejo: obtenga colores neutros capturando una toma de 
prueba con una tarjeta gris durante una sesión de fotos. 

Exposición
Utilice la herramienta “Exposición” de Capture One para 
ajustar la exposición, el contraste, el brillo y la saturación. 

Pruebe la herramienta “Alto rango dinámico” para corregir 
imágenes con altas luces extremas y sombras muy marca-
das. Utilice las eficaces herramientas “Niveles” y “Curva” 
para definir en detalle las exposiciones o dé más fuerza a 
una imagen con los controles deslizantes de “Nitidez”. 
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Edición de imágenes
Pruebe la función “Variantes” al editar imágenes para 
obtener una vista previa de la imagen seleccionada con 
los mismos ajustes aplicados. Utilice la función “Variantes” 
para experimentar con distintos ajustes de imagen. 

Pulse F3/F7 (Mac/PC) para obtener una variante clonada 
de la imagen seleccionada (o vaya a “Imagen” > “Clonar 
variante”). La nueva variante es, en esencia, un duplicado 
del archivo RAW original.

Corrección de lente
Utilice la herramienta “Corrección de lente” para minimizar 
la aberración cromática, el halo púrpura, la distorsión y la 
disminución de nitidez y luminosidad. Cree efectos crea-
tivos utilizando la herramienta “Viñeteado”.
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Recorte
La herramienta “Recorte” permite las opciones de recorte 
de proporción fija y a mano alzada. Incluso es posible 
recortar fuera de la zona de imagen. Arrastre la máscara 
de recorte al visor para realizar ajustes de composición en 
cualquier momento durante el proceso de edición.

Enfoque y definición
Verifique o modifique la definición de la imagen. Com-
pruebe siempre la definición con la vista de zoom al 100 %. 
Primero ajuste los controles deslizantes “Radio” y “Canti-
dad” y luego modifique el valor de “Umbral” según sea 
necesario.
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Ajustes locales 
La ficha de la herramienta “Ajustes locales” permite crear 
capas y ajustar zonas específicas de una imagen. Las 
funciones “Exposición”, “Definición”, “Nitidez” y “Moiré” y 
el “Editor de color” también se pueden aplicar a un ajuste 
local. La zona seleccionada se define mediante un pincel; 
la dureza y el tamaño se pueden ajustar en función de las 
necesidades de edición. 

Exportación
Hay dos modos de exportar una imagen: ir a “Archivo” 
> “Exportar” y elegir la opción “Originales” o la opción 
“Variante”. 

La opción “Exportar originales” permite exportar imá-
genes RAW originales con o sin ajustes a una ubicación de 
carpeta del equipo, de un disco duro externo, etc. (Active 
o desactive la casilla de verificación “Incluir ajustes” según 
sus preferencias). Pulse el botón “Exportar original” para 
concluir el proceso.
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La opción “Exportar variantes” es un modo rápido de 
exportar una imagen procesada. Vaya al menú desplegable 
“Almacenar archivos” y seleccione una ubicación. Asigne 
un nombre al archivo, seleccione un formato, ajuste el 
control deslizante “Calidad” a su gusto y pulse el botón 
“Exportar variantes” para concluir el proceso.

Lote
Vaya a la ficha de la herramienta “Lote” para ver las imá-
genes que están a punto de procesarse. Puede incluso 
volver a procesar imágenes directamente desde la ficha 
“Historial”, siempre que los archivos originales aún estén 
disponibles.
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I have always loved the way Capture One handles
my files, especially the colour and the detail in the
shadow areas. Now in Capture One 7, the colour
and detail are even better than before.

Quote by Photographer Peter Eastway

”
”
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Capture One Pro 7 is the world’s best raw converter, rendering precise  
colors and incredible detail with support for leading high-end cameras. 

It contains flexible, digital asset management, all the essential adjustment tools 
and fast, responsive performance in one customizable and integrated solution.

Insert im
age ©

 D
ouglas Sonders
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© Douglas Sonders
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Capture One 7 
the professional choice in imaging software
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Aktivera Capture One Pro 7
Följ denna guide för att aktivera programmet Capture One 
Pro 7. Guiden är uppbyggd steg för steg. Du måste vara 
ansluten till Internet för att slutföra aktiveringen.

1. Gå till Capture One>Licens... och öppna dialogrutan för 
aktivering av licens enligt bilden.

2. Skriv in licenskoden och profilinformationen.

Du får licenskoden (16 tecken) antingen via e-post eller 
i programmets originalförpackning. Skriv in licenskoden 
enligt bilden.

Skriv in e-postadressen som finns registrerad för ditt Phase 
One-konto. Om du inte har ett konto anger du din e-posta-
dress för att skapa ett nytt konto. Klicka på “Hämta profil”. 
Resten av formuläret fylls i automatiskt. Om du är ny kund 
fyller du i resten av formuläret manuellt. Klicka sedan på 
knappen “Aktivera”.

3. Slutför processen genom att klicka på “Aktivera”.  
Programmet är nu klart att använda.

Felsökning
Om du får problem med programmet kan du försöka med 
något av följande:

1. Läs manualen som finns i Hjälp-menyn eller gå direkt till 
http://help.phaseone.com. Här finns en omfattande online-
manual för programmet.

2. Se www.youtube.com/PhaseOneDK för de senaste  
videoklippen med instruktioner.
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3. Du kan även besöka www.phaseone.com/support för att 
få tips och hjälp med felsökning.

Komma igång
Den här guiden hjälper dig att komma igång med Capture 
One Pro 7. Besök www.phaseone.com/7 för att få informa-
tion om hur du kan få maximal nytta av programmet.

Användargränssnittet består av fyra huvudområden (se 
skärmbilden nedan):

1. Miniatyrläsaren visar olika vyer med bildminiatyrer samt 
användbara funktioner som underlättar arbetet, till exempel 
märkning, namn, sortering etc.

2. I Bildvisaren visas den markerade bilden i hög kvalitet. 
Alla ändringar av bilden visas direkt.

3. På verktygsflikarna finns alla verktyg som används för 
att redigera bilder, till exempel färgbalans, exponering och 
skärpa.

4. Menyn och verktygsfältet ger tillgång till programmets 
funktioner på ett välstrukturerat sätt.

Sessioner
Om du redan vet hur du arbetar med sessioner och vill 
fortsätta med det, är detta möjligt.

En session är en projektbehållare som i första hand in-
nehåller sökvägar till mappar och enheter som används i 
projektet. Om du skapar favoritmappar för de platser som 
används i projektet, kan du snabbt hitta och läsa in map-
parna.
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Sessioner är särskilt användbara när du jobbar med en 
ansluten kamera. Skapa en session för ansluten kamera, 
anslut kameran och hämta bilder direkt till Capture One. Det 
går snabbare än att importera bilderna efteråt. Fotografi-
erna kan granskas i realtid, vilket gör det möjligt för dig att 
finjustera bildparametrarna.

För mer information, se http://help.phaseone.com/en/CO7/
Optimizing-Your-Workflow/Working-in-Sessions.aspx.

Skapa en katalog
Om du inte vill arbeta med sessioner kan du istället välja att 
arbeta med kataloger.

En katalog är den huvudsakliga metoden för att organisera 
filer och visa dem i Capture One Pro 7. En katalog inne-
håller all information som krävs för att Capture One Pro 7 
ska hitta och visa bilder som läggs till i katalogen. 

Informationen inkluderar hur bilderna sorteras i katalogen, 
metadata och till och med vilka visuella justeringar som 
görs av bilderna.

De faktiska bildfilerna kan sparas på valfri enhet, men även 
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inne i själva katalogen. Du hittar och visar bildfiler med hjälp 
av verktyget Bibliotek. Bildfilerna måste importeras till en 
katalog. Det går även att ta ett fotografi direkt till en katalog 
med en kompatibel ansluten kamera.

1. Du skapar en katalog genom att välja Arkiv>Ny katalog.

2. En dialogruta öppnas. Fyll i fältet Namn och välj en plats 
för katalogen.

Importera bilder
Innan du importerar bilder skapar du en ny katalog eller 
session. Välj Arkiv>Ny katalog eller Ny session. Fyll i fältet 
Namn, ange en plats och klicka på OK.

Det finns tre sätt att importera bildfiler:

1. Anslut en kortläsare till datorn och sätt i ett minneskort. 
Importfönstret i Capture One öppnas automatiskt.

2. Importera filer från datorn eller en extern hårddisk genom 
att välja Arkiv>Importera bilder. Bläddra till en mapp som 
innehåller råa bildfiler i den nedrullningsbara listan Platser 
och markera mappen.

Dialogrutan Importera bilder har ett antal automatiska 
alternativ som du kan välja mellan beroende på hur du vill 
arbeta. Det finns ett verktyg för säkerhetskopiering av bild, 
en funktion för att namnge filer och för att lägga till bildtex-
ter och information om upphovsrätt.

3. Via ansluten kompatibel D-SLR-kamera eller kamera med 
digitalt bakstycke. Bilderna sparas i aktiv katalog/session 
som standard. 
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TA BILD
Verktygsfliken Ta bild är utgångspunkten för fotografering 
med en ansluten Phase One kamera med digitalt bakstycke 
eller kompatibel DSLR-kamera. Anslut en kamera till datorn 
via FireWire- eller USB-kabel.

På den här verktygsfliken finns en mängd olika funktioner 
som underlättar arbetet. Du kan till exempel ställa in kam-
erans exponering via datorn och lägga på justeringar och 
olika stilar under fotograferingen. Använd verktyget Kamera 

för att justera ISO- och vitbalansinställningar och aktivera 
slutaren på en ansluten kamera eller aktivera Live View-
funktionen.

Använd verktyget/appen Capture Pilot för att ansluta  
Capture One Pro 7 till en iPad, iPod Touch eller iPhone. 
Med hjälp av appen Capture Pilot kan du visa, märka och 
hämta bildfiler på en iOS-enhet.

Verktyget Capture Pilot har också en webbfunktion som 
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du kan använda för att visa, märka och färgtagga hämtade 
bilder från en webbläsare på en dator, Android-enhet (mobil 
enhet) eller Windows Phone-operativsystem.

Färg
Capture One har ett antal verktyg för färgjustering. Verkty-
gen är konstruerade för att underlätta arbetet med hanter-
ing av specifika element som vitbalans och hudtoner.

Verktygsfliken Färg och tillhörande funktioner bör vara det 
som arbetet med bildredigeringen baseras på. Selektiv 

färgredigering kan användas för att välja och justera ett 
smalt färgområde utan att andra färger i bilden påverkas.

Tips: Du får neutrala färger genom att ta en testbild med ett 
gråkort vid fotograferingen.
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Exponering
Använd verktyget Exponering i Capture One för att justera 
exponering, kontrast, ljusstyrka och mättnad.

Prova verktyget HDR (High Dynamic Range) för att justera 
bilder med kraftiga högdagrar och mörka skuggor. Du kan 
använda de kraftfulla verktygen för nivåer eller kurvor för att 
finjustera exponeringen, och du kan ge en bild mer stuns 
med hjälp av Skjutreglage för klarhet.

Redigera bilder
Prova funktionen Varianter när du redigerar bilder för att 
få en förhandsgranskning av den markerade bilden med 
aktuella justeringar. Använd Varianter för att experimentera 
med olika bildjusteringar.

Tryck på F3/F7 (Mac/PC) för att skapa en klonvariant av en 
markerad bild. (Du kan även gå till Bild>Klona variant.) Den 
nya varianten är i grund och botten en kopia av originalfilen.
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Objektivkorrigering
Använd verktyget Objektivkorrigering för att minimera 
kromatisk aberration, lila överstrålning, förvrängning samt 
ljus- och skärpebortfall. Du kan även skapa kreativa effekter 
med vinjetteringsverktyget.

Beskära
Verktyget Beskära innehåller alternativ för såväl anpassad 
som proportionerlig beskärning. Du kan till och med göra 
beskärningar utanför bildområdet. Dra masken i bildvisaren 
för att justera bilden. Du kan göra detta när som helst under 
redigeringen.
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Fokus och skärpa
Bekräfta eller modifiera bildens skärpa. Kontrollera alltid 
skärpan med zoomvärdet 100 %. Justera först reglagen 
för radie och mängd och justera sedan tröskelvärdet efter 
behov.

Lokala justeringar
Du kan använda verktygsfliken Lokal justering för att skapa 
lager och justera vissa områden i en bild. Du kan även 
lägga till exponering, skärpning, klarhet, moaré och selektiv 
färgredigering på en Lokal justering. Du markerar aktuellt 
område med hjälp av en pensel och kan justera hårdhet och 
storlek efter önskemål.
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Export
Det finns två alternativ för att exportera bilder: Gå till 
Arkiv>Export och välj antingen alternativet Original eller 
Variant.

Exportera original kan du använda för att exportera origi-
nalbilder med eller utan justeringar till en mapp på datorn 
eller en extern hårddisk etc. (Markera alternativet “Inkludera 
justeringar” om du så önskar.) Klicka på Exportera original 
för att slutföra processen.

Exportera varianter är ett snabbt sätt att exportera en 
bearbetad bild. Gå till den nedrullningsbara listan Lagra 
filer och välj en plats. Ge filen ett namn, välj ett format och 
justera kvalitetsreglaget enligt dina önskemål. Klicka sedan 
på Exportera varianter för att slutföra processen.

KÖ
Gå till verktygsfliken Kö för att visa bilder som ska bearbe-
tas. Du kan även omredigera bilder direkt från historikfliken, 
så länge originalfilerna fortfarande finns tillgängliga.
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Capture One 7 
the professional choice in imaging software
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Активизация Capture One Pro 7
Следуйте указаниям этого пошагового руководства 
для активизации программного обеспечения Capture 
One Pro 7. Для завершения активизации требуется 
подключение к Интернету.

1. Выберите пункт Capture One>License... (Лицензия...), 
чтобы открыть диалоговое окно активизации, как 
показано на рисунке.

2. Введите код лицензии и сведения о профиле. 

Вы получите 16-значный код лицензии либо по 
электронной почте, либо в составе исходного пакета 
программного обеспечения. Введите код лицензии, как 
показано на рисунке.

Введите адрес электронной почты, соответствующий 
вашей учетной записи Phase One; если учетная запись 
отсутствует, она будет создана. Нажмите кнопку «Get 
profile» (Получить профиль) — остальные поля формы 
будут заполнены автоматически. Если вы новый клиент, 
заполните остальные поля формы. Затем нажмите 
кнопку «Activate» (Активировать).

3. Завершите эту операцию, нажав кнопку «Activate» 
(Активировать). Теперь программное обеспечение 
готово к использованию.

Устранение неполадок
В случае каких-либо неполадок с программным 
обеспечением попробуйте обратиться к следующим 
ресурсам.
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1. Ознакомьтесь с руководством пользователя в меню 
Help (Справка) или перейдите непосредственно на 
веб-сайт http://help.phaseone.com для ознакомления с 
полным интерактивным руководством пользователя 
программного обеспечения.

2. Посмотрите последние учебные видеоматериалы на 
странице www.youtube.com/PhaseOneDK. 

3. Ознакомьтесь с творческими идеями и 
рекомендациями по устранению неполадок, 
приведенными на странице www.phaseone.com/support.

Краткое руководство
Это краткое вводное руководство по началу работы 
с программой Capture One Pro 7. Полные сведения 
по наиболее эффективному использованию этого 
программного обеспечения приведены на веб-странице 
www.phaseone.com/7.

Пользовательский интерфейс состоит из четырех 
основных разделов, как показано на приведенном ниже 
примере экрана.

1. В браузере отображаются различные представления 
эскизов (превью) изображений, а также функции, 
помогающие при работе, включая выставление оценок, 
присвоение имен, сортировку и другие функции.

2. Область просмотра обеспечивает 
высококачественное отображение выбранного 
изображения. Все изменения, сделанные в 
изображении, сразу же отображаются.  

3. Вкладки инструментов предоставляют доступ к 



русский

90

основным инструментам редактирования изображений, 
таким как цветовой баланс, баланс белого, экспозиция 
и резкость.

4. Меню и панель инструментов обеспечивают 
упорядоченный доступ к функциям программного 
обеспечения и другим функциям приложения.

Сеансы (Сессии)
Если вы уже знакомы с сеансами (сессиями) и хотите 
продолжать работать с ними, это можно сделать 
следующим образом.

Создайте сеанс (сессию) в качестве контейнера 
проекта, в котором в основном хранятся расположения 
папок и пути к дискам, используемым в проекте. 
Для удобного доступа и быстрой загрузки папок 
можно создать избранные папки для расположений, 
используемых в конкретном проекте.

Сеансы (Сессии) особенно удобны при съемке 
с проводным подключением (непосредственно 
на компьютер или ноутбук). Просто создайте 
подключенный сеанс (новую сессию), подсоедините 

камеру и снимайте изображения непосредственно 
в программу Capture One. Это позволяет экономить 
время по сравнению с импортом изображений после 
съемки. Снимок можно изучить сразу после съемки, 
что помогает точно настроить параметры изображений.

Подробнее см. по ссылке: http://help.phaseone.com/en/
CO6/Optimizing-Your-Workflow/Working-in-Sessions.aspx

Создание каталога
Вместо работы с сеансами (сессиями) можно 
использовать каталоги.

Каталог является основным способом систематизации 
и просмотра файлов в приложении Capture One Pro 
7. Каталог содержит всю информацию, необходимую 
приложению Capture One Pro 7 для поиска и 
отображения любого изображения, добавленного в 
этот каталог. 

Эта информация включает в себя способ 
систематизации изображений в каталоге, метаданные 
и даже визуальные настройки, примененные к 
изображениям.
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Фактические файлы изображений могут находиться 
в любом расположении на диске, но могут также 
размещаться непосредственно внутри файла каталога. 
Для размещения файлов изображений и доступа к 
ним служит инструмент Library (Библиотека). Файлы 
изображений необходимо импортировать в каталог. 
Можно также производить съемку непосредственно 
в каталог с помощью поддерживаемой подключаемой 
камеры. 

1. Создайте каталог, выбрав пункт File (Файл)>New 
Catalog... (Создать каталог...). 

2. Открывается диалоговое окно. Заполните поле Name 
(Имя) и выберите расположение для каталога.

Импорт изображений
Перед импортом изображений требуется 
предварительно создать новый каталог или сеанс. 
Выберите File (Файл)>New Catalog (Создать каталог) или 
New Session (Создать сеанс (Новая сессия)). Заполните 
поле Name (Имя), выберите расположение и нажмите 
кнопку OK.
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Предусмотрено три основных способа импорта файлов 
изображений. 

1. Подсоедините устройство чтения карт к компьютеру 
и установите карту памяти. Приложение Capture One 
автоматически откроет окно импорта. 

2. Импортируйте файлы с компьютера или с внешнего 

жесткого диска, выбрав File (Файл)>Import images... 
(Импорт изображений...). Найдите и выберите папку 
с необработанными изображениями с помощью 
раскрывающегося меню Location (Расположение). 

В диалоговом окне Import Images (Импорт изображений) 
предусмотрено несколько автоматических функций, 
которые можно выбирать в зависимости от требуемого 
рабочего процесса. Сюда входят инструмент 
резервного копирования изображений, функция 
назначения имен файлов, а также поля добавления 
подписей и информации об авторских правах.

3. Производите съемку с поддерживаемого цифрового 
зеркального фотоаппарата или цифрового задника, 
подключенного кабелем. Изображения по умолчанию 
записываются в активный каталог или сеанс (сессию). 

Захват
Вкладка инструмента захвата — это средство 
съемки с помощью поддерживаемых Phase One 
цифровых задников или цифровых зеркальных 
камер, подключенных кабелем. Подключите камеру к 
компьютеру с помощью кабеля FireWire или USB 3.0. 
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На этой вкладке инструментов предусмотрено 
множество удобных в работе функций. Во время 
захвата можно дистанционно задавать настройки 
экспозиции в камере, применять регулировки и 
несколько стилей. С помощью инструмента Cam-
era (Камера) можно изменять значение числа ISO и 
настройки баланса белого, а также спускать затвор 
подключенной камеры или включать режим Live View. 

Используйте инструмент или приложение Capture 
Pilot для подключения приложения Capture One Pro 

7 к iPad, iPod Touch или iPhone. Приложение Capture 
Pilot позволяет представлять, оценивать и захватывать 
файлы изображений на устройствах с ОС iOS.  

В инструменте Capture Pilot также предусмотрена 
интернет-функция, позволяющая просматривать, 
оценивать и помечать цветными метками захваченные 
изображения с помощью браузера на компьютере, а 
также на устройствах с операционной системой Android 
(мобильные устройства) или Windows Phone.   
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Цвет
В приложении Capture One предусмотрен ряд 
инструментов настройки цветов. Эти инструменты 
предназначены для работы с такими специальными 
аспектами, как баланс белого и телесные оттенки. 

Вкладка инструмента цвета и ее функциональные 
возможности — это краеугольный камень всех 
процессов редактирования изображений. Редактор 
цветов позволяет пользователям выбирать и 

настраивать узкий спектр цветов, не затрагивая другие 
цвета изображения. 

Рекомендация: для получения нейтральных цветов 
во время съемки фотографий произведите тестовую 
съемку серой карты. 
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Экспозиция
Инструмент экспозиции программы Capture One служит 
для настройки экспозиции, контрастности, яркости и 
насыщенности. 

Попробуйте использовать инструмент широкого 
динамического диапазона для исправления 
изображений с сильной засветкой или глубокими 
тенями. Используйте мощные инструменты Lev-
els (Уровни) и Curve (Кривая) для точной настройки 

экспозиции и улучшения изображения с помощью 
ползунков Clarity (Чистота (Четкость)). 

Редактирование изображений
При редактировании изображений попробуйте 
использовать функцию Variants (Варианты) для 
предварительного просмотра выбранного изображения 
с одинаковыми примененными настройками. 
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Используйте функцию Variants (Вариант) для 
экспериментирования с различными настройками 
изображений. 

Нажмите клавишу F3/F7 (Mac/PC), чтобы получить 
клонированный вариант выбранного изображения. 
(Можно также выбрать Image (Изображение)>Clone 
Variant (Клонировать вариант)). Пункт New Variant 
(Новый вариант) фактически позволяет создать копию 
исходного необработанного файла.

Коррекция искажений объектива
Инструмент Lens Correction (Коррекция искажений 
объектива) служит для сведения к минимуму эффектов 
хроматической аберрации, пурпурной окантовки, 
дисторсии, снижения яркости и резкости. Инструмент 
виньетирования позволяет получать творческие 
эффекты.

Кадрирование
Инструмент Crop (Кадрирование) поддерживает 
свободное кадрирование и кадрирование с 
фиксированным соотношением сторон кадра. 
Возможно даже кадрирование за пределами области 
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изображения. Перетаскивайте маску кадрирования 
в области просмотра для настройки композиции на 
любом этапе процесса редактирования.

Фокус и повышение резкости
Можно проверять или изменять резкость изображения. 
Обязательно проверяйте резкость при масштабе 100%. 
Сначала настраивайте ползунки Radius (Радиус) и 

Amount (Величина), затем изменяйте значение Threshold 
(Порог).

Локальные настройки 
Вкладка инструмента локальных настроек позволяет 
создавать слои и настраивать конкретные области 
изображения. К местным настройкам также могут 
применяться экспозиция, резкость, четкость, муар 
и редактор цветов. Выбранная область задается с 



русский

98

помощью кисти; жесткость и размер кисти могут 
настраиваться в соответствии с требованиями к 
редактированию. 

Экспорт
Предусмотрено два варианта экспорта изображений: 
выберите File (Файл)>Export (Экспорт), затем выберите 
пункт Originals (Оригиналы) или Variant (Вариант). 

Пункт Export Originals (Экспорт оригиналов) 
позволяет экспортировать оригинальные 
необработанные изображения с настройками или без 
настроек в папку на компьютере, внешнем жестком 
диске и т. п. (если требуется, установите флажок 
«Include Adjustments» (Включая настройки)). Для 
завершения операции нажмите кнопку Export Original 
(Экспорт оригинала).
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Пункт Export Variants (Экспорт вариантов) — это 
быстрый способ экспорта обработанного изображения. 
Перейдите в раскрывающееся меню Store Files 
(Сохранить файлы) и выберите расположение. Задайте 
имя файла, выберите формат, установите в требуемое 
положение ползунок Quality (Качество) и нажмите 
кнопку Export Variants (Экспорт вариантов), чтобы 
завершить операцию.

Пакетная обработка  
Перейдите на вкладку инструмента пакетной 
обработки, чтобы просмотреть изображения, 
готовые к обработке. Если доступны исходные 
файлы, можно даже заново обработать изображения 
непосредственно на вкладке журнала.
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Capture One 7 
the professional choice in imaging software
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激活 Capture One Pro 7
按照本指南中的分步说明，激活 Capture One Pro 7 软件。
要完成激活，您需要连接到互联网。

1. 转到“Capture One”>“许可证...”，如图所示打开许
可证激活对话框。

2. 输入许可证代码和配置文件详细信息。 

您将通过电子邮件或通过原始软件包获得由 16 个字符组成的
许可证代码。如图所示，输入许可证代码。

输入关联到 Phase One 账户的电子邮件地址，如您没有账
户，将为您创建一个账户。按“获取配置文件”，系统将自
动为您填写余下表格内容。如果您是新客户，请填写余下表
格内容。现在，点击“激活”按钮。

3. 点击“激活”，完成此流程。软件现已准备就绪可以使
用。

故障排除
如软件出现任何问题，请尝试以下任一资源：

1. 阅读“帮助”菜单中的用户指南或直接访问 http://help.

phaseone.com 查找全面的软件在线指南。

2. 访问 www.youtube.com/PhaseOneDK 观看最新的视
频教程。

3. 访问 www.phaseone.com/support 查找资料，排除故
障。

入门指南
本文档是 Capture One Pro 7 的入门指南。请访问 www.
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phaseone.com/7 获得如何充分利用软件功能的完备详细
信息。

用户界面由四个主要部分组成，如以下截图所示：

1. 浏览器，以不同的视图显示图像缩略图，以及用于辅助工
作流的有用功能，包括评级、命名、排序等。

2. 预览，以较高品质显示您所选择的图像。对图像所作的所
有更改将即时显示。  

3. “工具”选项卡中提供编辑图像所需的所有核心工具，例
如色彩平衡、曝光和锐度等。

4. 菜单和工具栏可通过结构化方式，访问应用程序中的各种
软件功能。

会话
如果您已经熟悉并且更愿意继续使用会话，则可执行以下操
作：

创建一个会话作为项目容器，主要用来存储项目中使用的文
件夹位置和驱动器路径。为快速访问以及迅速加载文件夹，
可为特定项目中使用的位置创建收藏夹。

在使用联机拍摄时，会话尤为有用。只需创建一个联机会
话，插入相机，然后将图像直接捕捉到 Capture One。与拍
摄后导入图像相比，这样做比较省时。拍摄过程中可认真检
查，以便调整图像参数。

如需更多详细信息，请访问：http://help.phaseone.com/
en/CO6/Optimizing-Your-Workflow/Working-in-Sessions.
aspx
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创建目录
如不使用会话，也可以使用目录。

目录是 Capture One Pro 7 中的主要文件组织和查看方法。
目录中含有 Capture One Pro 7 用于查找和显示添加到目录
中的任何图像所需要的全部信息。 

这些信息包括图像在目录中的组织方法，元数据以及对图像
所作的视觉调整。
实际图像文件可位于磁盘上的任何位置，也可放在目录文件
本身当中。图像文件的查找和访问在库工具中进行。图像文
件需导入目录。还可从受支持的联机相机直接拍摄到目录
中。 

1 选择“文件”>“新建目录...”创建目录 

2. 随即出现一个对话框。填写名称字段，然后为目录选择一
个位置。



105

简体中文

导入图像
导入图像前，先创建一个新的目录或会话。转到“文件”>“
新建目录”或“新建会话”。填写“名称”字段，选择一个
位置，然后按“确定”。

主要有三种方法可用于导入图像文件： 

1. 将读卡器连到计算机，然后插入内存卡。Capture One 
将自动打开导入窗口。 

2. 选择“文件”>“导入图像...”从计算机或外部硬盘导入文
件。从“位置”下拉菜单中，浏览并选择一个含有原始图像
的文件夹。 

“导入图像”对话框中有很多自动化选项，可根据您的工作
流偏好进行选择。其中包括图像备份工具、文件命名功能以
及添加说明和版权信息字段。

3. 从受支持的数码单反或数码后背进行联机拍摄。默认情况
下，图像将进入当前活动的目录/会话。 
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捕捉
捕捉工具选项卡是利用 Phase One 的数码后背或受支持的
数码单反进行联机拍摄的入口。通过 FireWire 或 USB 线将相
机连接到计算机。 

此工具选项卡拥有众多用于辅助工作流的功能。远程调整相
机的曝光设置，在捕捉过程中进行调整和应用多种模式。用
相机工具更改 ISO 和白平衡设置，按下所连接相机的快门或
激活实时预览功能。 

使用“拍摄领航员”工具/应用程序，将 Capture One Pro 7 
连接到 iPad、iPod Touch 和 iPhone。“拍摄领航员”应用
程序允许您在 iOS 设备上呈现、评定并捕捉图像文件。  

“拍摄领航员”工具还有一种 Web 功能，用于从计算机、
安卓（移动设备）或 Windows Phone 操作系统上的 Web 
浏览器查看、评定并用颜色标记捕捉到的图像。   
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色彩
Capture One 拥有多种用于调整色彩的工具。这些工具设
计用于为您处理白平衡和肤色等特定问题时的工作流提供支
持。 

色彩工具选项卡及其功能一直是图像编辑工作流的基石。“
色彩编辑器”能帮助用户选择一个较窄的色彩频谱并进行调
整，而不会对图像中的其他色彩造成影响。 

提示：在拍摄照片时，可以使用灰卡试拍一张照片以获得中
性色。 
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曝光
使用 Capture One 的曝光工具，调整曝光、对比度、亮度
和饱和度。 

利用高动态范围工具，修复过度高光和阴影较深的图像。借
助强大的色阶与曲线工具，可精确调节曝光，或通过清晰度
滑块增强图像的显示效果。 

编辑图像
编辑图像时尝试使用变体功能，预览选定图像在应用相同调
整后的效果。使用变体功能试验不同的图像调整效果。 

按 F3/F7 (Mac/PC) 可获得选定图像的复制变体。（也可以
通过点击“图像”>“复制变体”获得）。新变体在本质上就
是原始文件的副本。
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镜头校正
使用镜头校正工具可最大限度地减少色差、紫边、畸变、亮
度和锐度衰减等情况。利用渐晕工具可获得创造性的效果。

裁剪
裁剪工具拥有手绘和固定比例两种裁剪选项。甚至还可以在
图像区域外进行裁剪。编辑过程中，可随时在预览中拖动裁
剪遮罩，进行组合调整。
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焦点和锐化
检查或修改图像的锐度。检查锐度时，应始终采用 100% 比
例的缩放视图。首先，调整半径和数量滑块，然后根据需要
更改阈值。

本地调整
利用“本地调整”工具选项卡，可以创建图层并调整图像的
目标区域。曝光、锐化、清晰度、莫尔条纹和色彩编辑器也
可应用于本地调整。选定区域用画笔定义；可根据编辑需要
调整硬度和大小。 
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导出
导出图像有两种选项；单击“文件”>“导出”，选择“原始
文件”或“变体”选项。 

导出原始文件允许您导出原始图像，并可选择是否包含对计
算机或外部硬盘等上的文件夹位置所作的调整（根据偏好，
勾选“包含调整”选项）。按“导出原始文件”完成此流
程。

导出变体是导出已处理图像的快速方法。转到“存储文件”
下拉菜单，选择一个位置。根据需要命名文件，选择格式并
调整质量，然后按“导出变体”完成此流程。

批处理
转到“批处理”工具选项卡，查看需要处理的图像。只要原
始文件仍然可用，甚至可直接从历史记录选项卡重新处理图
像。
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Capture One Pro 7 の起動
本ガイド記載の手順にしたがって、Capture One Pro 7 ソ
フトウェアの認証（アクティベーション）を行ってくださ
い。を起動してください。認証操作起動操作を完了するに
は、インターネットに接続している必要があります。

1. 図のように、[Capture One] の [ライセンス...] を選択し、
ライセンス認証起動ダイアログを開きます。

2. ライセンスコードおよびプロファイルの詳細を入力しま
す。 

16桁のライセンスコードは、E メールでご提供します。
またはご購入いただいたソフトウェアのパッケージに記載
されています。図のように、ライセンスコードを入力しま
す。

Phase One Account に登録されている E メールアドレスを
入力します。アカウントをお持ちでない場合は、アカウン
トがを作成されますします。[自動入力Get profile] (プロフ
ァイルを取得する) を押すと、フォームファーム内のフィー
ルドにお客様の情報が入力されます。新規のお客様は、フ
ォームファーム内のフィールドに直接入力してください。
入力後、[起動する] ボタンをクリックします。

3. [起動する] をクリックしてこのプロセスを完了します。
これでソフトウェアを使用する準備が整いました。

トラブルシューティング
ソフトウェアを使用することで問題が発生した場合は、以
下をお試しください。

1. [ヘルプ] メニューにある『ユーザーガイド』をお読みく
ださい。または直接ソフトウェアに関する総合オンライン
ガイド（http://help.phaseone.com）にアクセスしてくださ
い。



115

日本語

2. 最新のチュートリアルビデオ(www.youtube.com/Pha-
seOneDK) をご覧ください。 

3. 解決のヒントやトラブルシューティングについて
は、www.phaseone.com/support にアクセスしてくださ
い。

ご使用にあたって
これは、Capture One Pro 7 の使用を始めるためのガイド
です。このソフトウェアを最大限に活用する方法の詳細
は、Visit www.phaseone.com/7 にアクセスしてください。

ユーザーインターフェイスは以下のスクリーンショットの
ように 4 つの主要セクションで構成されています。

1. 「ブラウザ」は、イメージサムネイルを表示します（
表示方法を選択できます）。また、レーティング、名前設
定、ソート、など作業に役立つ機能を表示します。

2. 「ビューア」は、選択したイメージを高品質画像で表示
します。イメージへの変更はすべて即座に反映されます。  

3. 「ツールタブ」は、カラーバランス、露出、シャープネ
ス鮮明度など、イメージを編集するために必要となる主要
なツールすべてを提供します。

4. 「メニューバー」と「ツールバー」は、ソフトウェアの
機能やアプリケーション経由で使用できる機能への構造化
されたアクセスを提供します。

セッション
すでにセッションを使い慣れている方やセッションでの作
業を希望される方はセッションをお使いいただけます。

プロジェクトの「箱」単位としてセッションを作成しま
す。この「箱」単位は、主にフォルダの場所とプロジェク
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トで使用するドライブへのパスを保存するのに使用しま
す。フォルダにすぐにアクセスすることや、素早くフォル
ダを読み込むみため、特定のプロジェクトで使用される場
所を保存するお気に入りフォルダを作成できます。

セッションは、特に連結撮影テザー撮影をする際に役立ち
ます。連結タイプのセッションを作成して、カメラを接続
後、Capture One に直接イメージをキャプチャーするだけ
です。これは、撮影後にイメージをインポートするより時
間を節約できます。撮影時に撮影イメージを綿密に吟味す
ることができ、イメージパラメーターの微調整に役立ちま
す。

詳細は、以下のリンクにアクセスしてください。
http://help.phaseone.com/en/CO6/Optimizing-Your-Work-
flow/Working-in-Sessions.aspx

カタログの作成
セッションの代わりにカタログで作業をすることもできま
す。

カタログは、Capture One Pro 7 でのファイル整理とフ
ァイル表示に使用される基本的な方法です。カタログに
は、Capture One Pro 7 でカタログに追加されたイメージ
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を検索し、表示するために必要となる情報がすべて含まれ
ています。 

情報には、カタログ内でのイメージ整理方法やメタデータ
だけでなく、イメージに対して行われた補正も含まれま
す。

実際のイメージファイルはディスク上のどの場所にも置く
ことができますが、カタログファイル自体にも置く必要が
あります。イメージファイルは、[ライブラリ] ツール内に
配置され、[ライブラリ] ツール内で使用できます。イメー
ジファイルはカタログ内にインポートする必要がありま
す。連結撮影テザー撮影をサポートしているカメラから直
接カタログにイメージを撮影することも可能です。 

1 [ファイル] から [新規カタログ…] を選択し、カタログを
作成します。 

2. ダイアログボックスが表示されます。[名前] のフィール
ドを入力し、[カタログの場所] を選択します。

イメージのインポート
イメージをインポートする前に、まず新しいカタログまた
はセッションを作成します。[ファイル] から [新規カタロ

グ…] または [新規セッション…] を開きます。[名前] のフィ
ールドを入力し、場所を選択して [OK] を押します。

イメージファイルのインポートには、3通りの方法があり
ます。 

1. カードリーダーをお使いのコンピューターに接続し、メ
モリカードを挿入します。Capture One でインポートウィ
ンドウが自動的に開きます。 
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2. [ファイル] から [イメージのインポート…] を選択し、
コンピューターまたは外付けのハードドライブからファイ
ルをインポートします。[場所] ドロップダウンメニューか
ら、RAW 画像を含むフォルダを参照、選択します。 

[インポートイメージ] ダイアログボックスにはさまざまな
自動化オプションがあり、作業の詳細設定に合わせて選択
できます。オプションにはイメージバックアップツール、
名前付け機能、説明や著作権の情報フィールドの追加など
が含まれます。

3. サポートされているデジタル一眼レフカメラ (DSLR) ま
たはデジタルバックから連結撮影テザー撮影を行います。
デフォルトでは、イメージは有効なカタログ / セッション
に保存されるよう設定されています。 

キャプチャー
[キャプチャー] ツールタブは、Phase One デジタルバッ
クまたはサポートされている一眼レフカメラ (DSLR) で
連結撮影テザー撮影をする際のゲートウェイとなりま
す。FireWire または USB ケーブルでお使いのコンピュータ
ーにカメラを接続します。 

このツールタブには、作業の助けとなる多くの機能があり
ます。カメラの露出設定をリモートで調整し、キャプチャ
ー中に調整やさまざまなスタイルを適用できます。[カメ
ラ] ツールを使用して、ISO感度やホワイトバランスの設定
変更や接続されたカメラのシャッタースピードの設定、[ラ
イブビューLive View] 機能の有効化などを行うことができ
ます。 

Capture One Pro 7 を iPad、iPod Touch、iPhone に接続す
る場合は、[Capture Pilot] ツール / アプリケーションを使用
します。[Capture Pilot] アプリケーションは、iOS デバイス
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のイメージファイルの表示、レーティング、キャプチャー
を可能にします。  

また、[Capture Pilot] ツールにはウェブ機能があり、コンピ
ューター、Android (携帯デバイス) または Windows Phone 
の OS 上のウェブブラウザからキャプチャーされたイメー
ジを表示、レーティング、カラータグ付けすることができ
ます。   

カラー
Capture One は、カラーを調整するためのさまざまなツー
ルを提供しています。各種ツールは、ホワイトバランスや
スキントーン等、特定の問題に対処する際、作業をサポー
トするために作られています。 

[カラー] ツールタブとその機能は、常にイメージ編集作業
の基礎となります。[カラーエディター] は、イメージの他
の色に影響を与えることなく、狭いカラースペクトルを選
択、調整することを可能にします。 
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お役立ち情報：撮影中グレーカードを使用してテスト撮影
イメージをキャプチャーすることで、ニュートラルな色が
得られます。 

露出
Capture One の [露出] ツールを使用し、露出、コントラス
ト、明度、彩度を調整します。 

極度のハイライトや濃いシャドウのあるイメージの補正に
は、[ハイダイナミックレンジ] ツールをお試しください。
強力な [レベル] と[カーブ] ツールを使用して、露出を微調
整します。もしくは、[透明度] スライダーを使用してイメ
ージをよりくっきりさせます。 
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イメージの編集
イメージを編集する際、同じ調整が適用された状態で選択
したイメージのプレビューを表示させるため、[バリアント] 
機能をお試しください。さまざまなイメージ調整を試すた
めに [バリアント] を使用します。 

Mac の場合は F3、Windows の場合は F7 を押し、選択した
イメージのバリアントのクローンを作成します(もしくは、[
イメージ] の [バリアントのクローン作成] を選択します)。[
新規バリアント] は、基本的にオリジナルの RAW ファイル
の複製となります。

レンズ補正
色収差、パープルフリンジ、明るさ、鮮明度の低下を最小
限に抑えるために [レンズ補正] を使用します。[ビネット] 
ツールを使用して、クリエイティブな効果を与えることが
できます。



日本語

122

クロップ
[クロップ] ツールは、フリーハンドまたは比率設定による
クロップを可能にします。イメージ領域外をクロップする
ことも可能です。クロップマスクを [ビューア] にドラッ
グすると、編集中いつでも構図の調整を行うことができま
す。

フォーカスおよびシャープニングシャープ
イメージの鮮明度を確認または修正します。必ず 100% ズ
ーム表示で、鮮明度を確認します。まず、[半径] と [量] の
スライダーを調整し、次に必要に応じて [しきい値] を変更
します。
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部分調整ローカル調整 
[部分調整ローカル調整] ツールタブでは、レイヤーを作成
し、イメージの対象領域を調整できます。また、[露出]、[
シャープニングシャープ]、[透明度]、[モアレ]、[カラーエデ
ィター] もローカル調整に適用できます。選択された領域は
ブラシで定義できます。編集のニーズに合わせて硬さとサ
イズを調整できます。 

エクスポート
イメージをエクスポートするためのオプションが 2 つあり
ます。[ファイル] から [エクスポート] を開き、[オリジナル] 
または [バリアント] オプションのいずれかを選択します。 

[オリジナルのエクスポート] は、お使いのコンピューター
または外付けハードドライブ等のフォルダにオリジナルの 
RAW イメージ (調整された状態または調整されていない状
態) をエクスポートすることを可能にします (ご希望に合わ
せ、[調整を含む] オプションにチェックを入れます)。[オリ
ジナルのエクスポート] を押し、処理を完了します。
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[バリアントのエクスポート]は、処理したイメージを手早く
即座エクスポートできる方法です。[ファイルの保存] ドロ
ップダウンメニューを開き、場所を選択します。ファイル
に名前を付け、ファイル形式を選択して、[画質] スライダ
ーを調節後、[バリアントのエクスポート] を押し、処理を
完了します。

バッチ  
[バッチ] ツールタブを開き、処理されるイメージを表示し
ます。元のファイルが利用可能であれば、[履歴] タブから
直接イメージを再処理することも可能です。
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Capture One 7 
the professional choice in imaging software
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Capture One Pro 7 활성화
이 단계별 안내서에 따라 Capture One Pro 7 소프트웨어를 
활성화하십시오. 활성화를 완료하려면 인터넷에 연결되어 있
어야 합니다.

1. Capture One>라이선스... 로 가서 그림과 같이 라이선스 
활성화 대화상자를 엽니다.

2. 라이선스 코드와 프로필 상세정보를 입력합니다. 

이메일이나 소프트웨어 패키지와 함께 16자리의 라이선스 
코드를 수령하게 될 것입니다. 이 라이선스 코드를 그림과 같
이 입력합니다.

사용자의 Phase One 계정과 연결된 이메일 주소를 입력하십
시오. 계정이 없을 경우, 계정을 만들어 드릴 것입니다. ‘프로
필 가져오기’를 누르면 양식의 나머지가 채워집니다. 신규 고
객의 경우, 이 양식의 나머지를 작성하면 됩니다. 이제 ‘활성
화’ 버튼을 클릭하십시오.

3. ‘활성화’를 클릭하여 이 절차를 완료합니다. 이제 소프트웨
어를 사용할 준비가 되었습니다.

문제 해결
소프트웨어에 문제가 있을 경우, 다음 리소스 중 하나를 시도
해 보십시오.

1. 도움말 메뉴에 있는 사용 안내서를 읽어 보거나 http://help.
phaseone.com으로 직접 가서 소프트웨어에 대한 전체 온라
인 안내서를 확인하십시오.

2. 최신 비디오 자습서는 www.youtube.com/PhaseOneDK에
서 확인하십시오. 



129

한국의

3. 힌트와 문제해결에 대한 내용은 www.phaseone.com/sup-
port를 방문하십시오.

시작하기
이 안내서는 Capture One Pro 7을 시작하기 위한 것입니다. 
이 소프트웨어를 최대한 활용하는 방법에 대한 자세한 내용
은 www.phaseone.com/7을 방문하십시오.

사용자 인터페이스는 아래의 스크린 샷에 표시된 바와 같이 
4가지 섹션으로 구성됩니다.

1. 브라우저는 이미지 섬네일의 다양한 보기와 등급, 명명, 정
렬 등을 포함하여 작업흐름을 돕는 유용한 기능을 표시합니
다. 

2. 뷰어는 사용자가 선택한 이미지의 고품질 버전을 제공합
니다. 이미지에 대한 모든 변경사항은 즉시 표시됩니다.  

3. 도구 탭은 컬러 밸런스, 노출 및 선명도와 같이 이미지를 
편집하기 위해 필요한 모든 주요 도구에 대한 액세스를 제공
합니다.

4. 메뉴와 도구 모음은 응용 프로그램 전반에 있는 소프트웨
어 기능과 특징에 대한 체계적인 액세스를 제공합니다.

세션
세션에 대해 이미 잘 알고 계속 사용하기를 원한다면, 다음의 
방법으로 사용할 수 있습니다.

프로젝트에서 사용하는 드라이브에 폴더 위치와 경로를 주로 
저장하는 프로젝트 컨테이너로서 세션을 생성하십시오. 폴더
에 대한 빠른 액세스와 로드를 원한다면 특정 프로젝트에서 
사용하는 위치에 대한 폴더를 생성할 수 있습니다.

세션은 테더 촬영을 할 때 특히 유용합니다. 테더 세션을 생
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성한 다음, 카메라에 연결하고 Capture One에서 직접 이미
지를 캡처하면 됩니다. 이렇게 하면 촬영 후 이미지를 가져오
는 경우보다 시간을 절약할 수 있습니다. 촬영을 하면서 면밀
히 관찰하면 이미지 매개변수를 미세 조정하는데 도움이 될 
수 있습니다.

자세한 내용은  http://help.phaseone.com/en/CO6/Optimiz-
ing-Your-Workflow/Working-in-Sessions.aspx로 가십시오.

카탈로그 생성
세션 작업을 대체하는 또 하나의 방법은 카탈로그를 활용하
는 것입니다.

카탈로그는 Capture One Pro 7에서 파일을 관리하고 보는 
주요 방법입니다.

카탈로그에는 추가된 이미지를 찾고 표시하기 위해 Capture 
One Pro 7에게 필요한 모든 정보가 포함되어 있습니다. 

이러한 정보에는 카탈로그에서 이미지를 구성하는 방법, 메
타데이터, 이미지에 대한 시각적 조정 등도 포함되어 있습니
다.

실제 이미지 파일의 위치는 디스크의 아무 위치나 될 수 있지
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만 카탈로그 파일 안에 위치할 수 있습니다.  이미지 파일은 
라이브러리 도구에 위치하며 여기에서 액세스합니다. 이미지 
파일은 카탈로그로 가져와야 합니다. 지원되는 테더 카메라
에서 카탈로그로 직접 촬영하는 것도 가능합니다. 

1. 파일 > 신규 카탈로그…를 선택하여 카탈로그를 생성합
니다. 

2. 대화상자가 나타납니다. 이름 필드를 작성하고 카탈로그 
위치를 선택합니다.

이미지 가져오기
이미지를 가져오기 전에 새로운 카탈로그나 세션을 먼저 생
성하십시오. 파일 > 신규 카탈로그 또는 신규 세션으로 갑니
다. 이름 필드를 작성하고 위치를 선택한 다음 확인을 누릅
니다.

이미지 파일을 가져오는 주요 방법에는 세 가지가 있습니다. 

1. 카드 리더를 컴퓨터에 연결하고 메모리 카드를 넣습니다. 
Capture One이 가져오기 창을 자동을 엽니다. 

2. 파일 > 이미지 가져오기…를 선택하여 컴퓨터나 외장 하드 
드라이브에서 파일을 가져옵니다. 위치 드롭다운 메뉴에서 

RAW 이미지가 포함된 폴더를 찾아 선택합니다. 

이미지 가져오기 대화상자에는 각자의 작업 성향에 따라 선
택할 수 있는 몇 가지 자동화 옵션이 있습니다. 여기에는 이
미지 백업 도구, 파일 명명 기능, 캡션 및 저작권 정보 추가 필
드 등이 포함됩니다.

3. 지원되는 DSLR 또는 디지털백에서 테더 촬영을 합니다. 
이미지는 기본적으로 활성 카탈로그/세션으로 이동합니다. 
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캡처
캡처 도구 탭은 Phase One 디지털백 또는 지원되는 DSLR을 
사용하여 테더 촬영하는 관문입니다. FireWire 또는 USB 케
이블을 통해 카메라를 컴퓨터에 연결합니다. 

이 도구 탭에는 작업 흐름에 도움이 되는 기능이 있습니다. 
카메라 노출 설정을 원격으로 조정하고 캡처하는 동안 조정 
및 다중 스타일을 적용합니다. ISO와 화이트 밸런스 설정을 
변경할 때 카메라 도구를 사용하고 연결된 카메라의 셔터를 
누르거나 라이브뷰 기능을 활성화합니다. 

Capture Pilot 도구/앱을 사용하여 Capture One Pro 7을 
iPad, iPod Touch 및 iPhone에 연결합니다. Capture Pilot 앱
으로 사용자는 iOS 장치에서 이미지 파일을 표시하고 평가하
고 캡처할 수 있습니다.  

Capture Pilot 도구에는 컴퓨터의 웹 브라우저, Android(모바
일 장치) 또는 Windows Phone 운영체계에서 캡처한 이미지
를 보고, 평가하고 컬러 태그할 수 있는 웹 기능이 있습니다.   
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컬러
Capture One은 컬러 조정을 위해 몇 가지 도구를 제공합니
다. 이 도구는 화이트 밸런스와 스킨 톤과 같은 특정 문제를 
처리할 때 작업 흐름을 지원하기 위해 만들어졌습니다. 

컬러 도구 탭과 그 기능은 이미지 편집 작업흐름의 기반이 되
어야 합니다. 컬러 에디터로 사용자는 이미지의 다른 컬러에 
영향을 주지 않고 좁은 컬러 스펙트럼을 선택 및 조정할 수 
있습니다. 

요령: 사진 촬영을 할 때 그레이 카드로 테스트 촬영을 캡처
하여 중간색을 얻도록 하십시오. 
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노출
Capture One Exposure 도구를 사용하여 노출, 대비, 밝기 및 
채도를 조정합니다. 

높은 계조 도구를 사용하여 과도한 하이라이트와 그림자를 
가진 이미지를 보완합니다. 노출을 미세 조정하거나 선명도 
슬라이더로 이미지에 활력을 더하려면 강력한 레벨 및 커브 
도구를 사용하십시오. 

이미지 편집
이미지를 편집하는 동안 변형 기능을 시험하여 동일한 조정
이 적용된 선택 이미지의 미리보기를 확인하십시오. 변형을 
사용하여 다양한 이미지 조정을 시험할 수 있습니다. 

F3/F7(Mac/PC)을 눌러 선택한 이미지의 클론 변형을 얻습니
다. (대안적으로 이미지 > 클론 변형으로 갑니다). 기본적으로 
새 변형은 원본 RAW 파일의 복제본입니다.
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렌즈 수정
렌즈 수정 도구를 사용하여 색수차, 퍼플 프린징, 왜곡, 명도, 
선명도 감소 등의 문제를 최소화합니다. 비네팅 도구를 사용
하여 독창적인 효과를 살립니다.

잘라내기
잘라내기 도구로 자유롭고 고정된 비율의 잘라내기 옵션을 
사용할 수 있습니다. 또한 이미지 영역 외부를 잘라낼 수도 
있습니다. 뷰어의 잘라내기 마스크를 끌어 편집 과정에서 아
무 때나 구성 조정을 할 수 있습니다.
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초점 및 선명 효과
이미지의 선명도를 확인하거나 수정합니다. 항상 100% 확대 
보기에서 선명도를 확인하십시오. 우선 반경 및 수치 슬라이
더를 조정한 다음 임계값을 필요에 따라 변경합니다.

로컬 조정 
부분 조정 도구 탭으로 층을 만들고 이미지의 목표 영역을 조
정할 수 있습니다. 노출, 선명 효과, 선명도, 모아레 및 컬러 
에디터를 로컬 조정에 적용할 수도 있습니다. 선택 영역은 브
러시로 처리했으며 편집 요구 사항에 따라 경도와 크기를 조
정할 수 있습니다. 
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내보내기
이미지 내보내기 옵션에는 두 가지가 있는데 파일 > 내보내
기로 가는 것과 원본 또는 변형 옵션 중 하나를 선택하는 것
입니다. 

원본 내보내기로 사용자는 조정하거나 조정하지 않은 원본 
RAW 이미지를 컴퓨터나 외장 하드 드라이브의 특정 폴더 위
치에 내보낼 수 있습니다(기호에 따라 ‘조정 포함’ 옵션을 체
크 표시). 원본 내보내기를 눌러 절차를 완료합니다.

변형 내보내기는 처리한 이미지를 신속하게 내보내는 방법
입니다. 파일 저장 드롭다운 메뉴로 가서 위치를 선택합니다. 
파일 이름을 명명하고 형식을 선택하고 품질 슬라이더를 원
하는 대로 조정한 다음 변형 내보내기를 눌러 절차를 완료합
니다.

일괄처리  
일괄처리 도구 탭으로 가서 처리될 이미지를 봅니다. 원본 파
일을 아직 사용할 수 있는 경우, 내역 탭에서 직접 이미지를 
재처리할 수도 있습니다.
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